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1. Introduction 

Congratulations on your purchase of the SoloVPE System! 
 
This manual is intended to introduce the technology and serve as a training document and reference resource. It is recommended 
that this manual be kept close to the device.  
 
This user guide provides general guidance for the use of systems running SoloVPE software 3.X.XXX.X. For further optimization or 
troubleshooting support, please contact your local Repligen Field Application Scientist (FAS). If you need assistance contacting your 
local FAS, the Customer Service team at Repligen would be happy to help (email: analytics-support@repligen.com; phone: 908-707-
1009). 
 
1.1 Data Naming Conventions 

Below is the list of each data-naming convention used in the software for the various types of data sets and examples to make it 
easier to interpret the data set types. 
 
Table 1. Data naming conventions table 

Continuum Type Examples  Derivation 

Quick Slope PLXQ{Sample}@280.00nm  

THXQ{Sample}@280.00nm 
 

PLX: Pathlength Cross Section  

THX: Threshold Cross Section  

Q: Quick Slope ID  

{Sample}: Sample Name  

@: Wavelength Leader 

#.##nm: Wavelength 

Fixed Quick Slope PLXF{Sample}@280.00nm  

THXF{Sample}@280.00nm  
 

PLX: Pathlength Cross Section  

THX: Threshold Cross Section  

F: Quick Slope ID 

{Sample}: Sample Name 

@: Wavelength Leader  

#.##nm: Wavelength  

Multi Quick Slope PLXM{Sample}@280.00nm  

THXM{Sample}@280.00nm 

PLX: Pathlength Cross Section  

THX: Threshold Cross Section  

Q: Quick Slope ID  

{Sample}: Sample Name  

@: Wavelength Leader 

#.##nm: Wavelength  

Quick Survey rawS{Sample}@0.250mm  

S{Sample}@.0250mm  

polyscan@0.005mm 

Raw: Raw type prefix  

S: Quick Survey ID 

{Sample}: Sample Name  

@: Pathlength Leader 

#.###mm: Pathlength 

mailto:analytics-support@repligen.com
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Section PLXA{Sample}@260.00nm PLX: PL Cross Section Prefix 

F, Q, S: Band ID 

{Sample}: Sample Name  

@: Wavelength Leader 

#.##nm: Wavelength 

Regression/Projected 
Regression 

regA{Sample}@280.00nm  

pregA{Sample}@260.00nm 

Preg: Projected Prefix 

Reg: Regression Prefix  

F,Q, S: Band ID 

{Sample}: Sample Name  

@: Wavelength Leader 

#.##nm: Wavelength 

 
 
2. System Overview 

 

 
 
The CTech™ SoloVPE® System hardware is composed of several individual components that are integrated to enable variable 
pathlength technology. 
 
The SoloVPE System allows for dynamic adjustments of the optical pathlength between 0.005 mm (5 microns) and 15.000 mm, and 
the hardware components work seamlessly together to create the variable pathlength platform that enables the method known as 
Slope Spectroscopy®. 
 
2.1 Cary 60 Spectrophotometer 
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The SoloVPE instrument functions by drawing its power directly from the Agilent Technologies Cary 60 UV-Vis spectrophotometer. 
The Cary 60 requires a Dual Use Fiber Optic Coupler, provided by Repligen’s Analytics business unit, to ensure adequate light 
transmission through the Fiber Optic Cable to the SoloVPE instrument.  
 
Note: Please reference documentation included with the Cary 60 spectrophotometer and computer for component-specific 

requirements, instructions, and safety considerations. 
 
2.2 Dual Use Fiber Optic Coupler 

The Dual Use Fiber Optic Coupler functions as an optical bridge by intercepting the beam of light from inside the Cary instrument 
and coupling it into an optical fiber that brings it to the SoloVPE instrument and the sample itself. Reference the Dual Use Fiber Optic 
Coupler User Manual DOC0047 for additional information.  
 
2.3 SoloVPE Device and Components 

The SoloVPE device is the component of the system that differentiates the SoloVPE System from all other UV-Vis spectrophotometer 
systems. The patented variable pathlength technology enables the Slope Spectroscopy measurement technique and opens new 
capabilities to analysts by empowering the pathlength term of the Beer-Lambert law.  
 
As a user, it is important to become familiar with the key components and features of the SoloVPE device. The following images can 
be used as a visual resource during training and when working with the system. This manual uses several different phrases. Each 
phrase should draw the following level of attention: 
 

 

Quick Set 
Fibrette 

 

Detector 

Fibrette® Optical 
Component 

Vessel 
Holder 

 
Sample 

Platform 

Sample 
Vessel Holder 

 

Locking 
Vessel Holder 
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Figure 1. SoloVPE parts and components (cover up). 

 
Figure 2. SoloVPE parts and components (cover down). 

 
2.4 SoloVPE Consumables 

   

   

   

   

 

 
Figure 3. Images of SoloVPE consumables. 

 

Cover 

Delivery Fiber 
Translation 

Stage 

Sample Vessel  
Holder Staging 

Fibrette Optical Components Sample Vessels 
(from left to right: plastic, Fused Silica Micro, 

Fused Silica Small, Fused Silica Large) 

Sample Vessel Holders 
(from left to right: Micro/Small, Large) 

  
 

TBA (Legacy) Fibrette Coupler 
Inserts 

Quick Set Fibrette 
Coupler Inserts 

Transmission Tool 

Quick Set Fibrette Coupler Inserts 



  

 

 
 11 
DOC0126 eRev. 11/17/2023 11/17/2023   

User Guide CTech™ SoloVPE® System (V3 Software) 

 
2.5 Solo Validation Cuvette Adapter (SoloVCA)*  

 
 
The SoloVCA is an optional accessory that works exclusively with SoloVPE variable pathlength spectrophotometer system. The 
SoloVCA was developed to provide an additional technique for validating the SoloVPE device, specifically allowing the use of cuvette-
form-factor filters and standards designed for standard spectrophotometers.  
 
*Note: The SoloVCA is not a general-use cuvette adapter that allows users to make standard cuvette measurements through the 

SoloVPE System. Use only as intended for validation purposes.  
 
2.6 SoloVPE System Software 

2.6.1 Computer Requirements 

If the application requires significant customization, please contact Repligen. We can also develop custom software if needed.  
 
The SoloVPE computer requirements are as follows: 

• Operating System: Windows 7 or Windows 10 Professional 64bit  
• CPU: Intel Processor: Processor speed > 2.0 GHz 
• RAM: 4 GB minimum 
• Storage: 2 GB of available space minimum 
• Ports: 4 USB mouse keyboard Cary portable USB drive 
• Display Port 1.2, HDMI 1.4, VGA, or DVI (Select the one that is compatible with monitor selected.) 

 
2.6.2 ADL and the ADL Shell Application 

Included with the Cary WinUV software suite is powerful programming language called the Applications Development Language 
(ADL). The programming language is similar to Visual Basic but has been specifically adapted for spectroscopic applications and the 
Agilent line of UV-Vis-NIR instruments. It provides control of the instrument and the software environment, allowing customization 
of Cary WinUV applications or creation of new applications designed to meet a user’s specific requirements. 
 
The Cary WinUV suite comes with an application called the ADL Shell. The ADL Shell program is a predesigned software environment 
template upon which custom applications can be written using ADL. The ADL Shell provides the core functionality and interfaces for 
the new ADL program to run. The SoloVPE control software takes advantage of the power of ADL and has been designed and tested 
in the ADL Shell environment. One of the most powerful features of this design is that new programs and applications can be written 
to the user’s specification. These can then take advantage of all the power of the SoloVPE instrument, the Cary 60, and the Cary 
WinUV software suite. 
 
2.6.3 SoloVPE Control Software 

The SoloVPE Control software controls both the SoloVPE device and the Agilent Cary 60. The software was written using the ADL 
provided with the Agilent Cary WinUV suite as described in Section 2.5.1. It is through the ADL language that the SoloVPE System can 
be set up, configured, and controlled to make UV-Vis measurements. The SoloVPE Control software runs in the ADL Shell 
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environment, although it can be configured for use with some of the other programs in the Cary WinUV suite. The SoloVPE Control 
software includes many powerful features and utilities that enable users to analyze data quickly and easily.  
 
2.6.4 SecureVPE and Program Security 

SecureVPE is an optional enhanced security module that works in conjunction with the security features of the Agilent Cary WinUV 
software and the Windows operating system. The SecureVPE module controls software permissions and access, method and reports 
modification privileges, eSignature capabilities, and audit trails.  
 
The modules work to secure the SoloVPE software based upon both a user and group permission model. The security module must 
be set up by personnel with administrator privileges at the installation location to comply with the requirements of that site. For 
more information see the SecureVPE User Manual DOC0019 or contact Repligen’s Analytics business unit.  
 
2.6.5 Commonly Used File Types 

There are several different files types that the Cary WinUV software and the SoloVPE software create and use. The following list 
summarizes the most commonly used file types. 
 
Software Tip: Press the TAB key to register the change (not the ENTER key). 
 
Table 2. Table of commonly used file types 

 
 
3. System Hardware Installation 

Please read and understand the following instructions prior to making any connections. These step-by-step directions guide the user 
through the process of making the four primary connections required between the computer, the Agilent Cary 60, and the SoloVPE 
instrument.  
 
Refer to the documents packaged with the computer and Cary 60 for further instruction on basic installation.   
 
The following steps should be carried out after speaking with a certified Repligen analytical representative for confirmation on 
setting up the System. Prior to starting, please clear and designate the laboratory bench space for the intended setup of the SoloVPE 
System. The SoloVPE instrument and Cary 60 may be set up, as shown below.  
 

File Type Extension Description 

Batch *.BVP Specific type of Cary WinUV file that contains SoloVPE System activity, including method 
information, data, graphics information, report content, security information, and audit trails. 

Comma-separated value 
Delimited 

*.CSV Text file format useful for transferring data between applications such as spreadsheet applications. 

Data *.DVP Data files save only the data. 

Method *.MVP Specific type of Cary WinUV files that contain a complete snapshot of the measurement parameters 
and hardware and software configurations of the SoloVPE System. Can be secured, transported, 
backed up, recalled, and applied as a quick and easy way to prepare the SoloVPE System for use. 

RTF *.RTF Text file format that includes simple formatting of fonts. 
Report *.RVP Report files save only the report. 

Grams *.SPC A data file capable of being read with Grams software. 



  

 

 
 13 
DOC0126 eRev. 11/17/2023 11/17/2023   

User Guide CTech™ SoloVPE® System (V3 Software) 

 
Figure 4. Dimensions of SoloVPE instrument, Cary 60 spectrophotometer, and computer. 

For any questions or queries, contact Repligen at US +1 908-707-1009 or analytics-support@repligen.com 
 

 

   
Figure 5. Optional configurations of SoloVPE instrument and Cary 60. 

3.1 System Hardware Installation: Step-by-Step 

 

Step 1: Unpack and Verify 

Carefully unpack the equipment and all accessories. Confirm receipt of all 
items on the packing list included with the shipment. 

Configuration 1: On top of the Cary 60 Configuration 2: Adjacent to the Cary 60 
 

mailto:analytics-support@repligen.com
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Step 2: System Computer Setup 

Use the instructions provided with the computer system for proper setup. It is 
best to complete the balance of this procedure with the computer turned off. 

 

Step 3: Connect Accessory Cable to Cary 60 

Connect the Accessory Cable to the Accessory Port located on the inside right 
of the Cary 60 sample compartment. The 25-pin male connector connects to 
the housing mounted inside the sample compartment. 

 

Step 4: Pass Accessory Cable through Access Panel 

Pass the female 25-pin connector of the Accessory Cable through the opening 
made available when the access panel was removed from the back of the Cary 
60. 
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Step 5: Connect Accessory Cable to SoloVPE Instrument 

Connect the Accessory Cable to the Accessory Port on the back of the SoloVPE 
instrument. The 25-pin female Accessory Cable connector mates to the 
instrument’s back panel. 

 

Step 6: Connect Detector Cable to SoloVPE device 

The Detector Cable has two different connectors. The black plastic connector is 
for the connection to the Cary 60. The silver connector is for the connection to 
the SoloVPE instrument’s back panel. The silver connector is keyed.  
To properly position the connector for insertion, align the red dots on the 
connector and the port and push firmly to make the connection to the back 
panel. 

 

Step 7: Attaching SoloVPE Strain Relief  

The Delivery Fiber Strain Relief is shipped with the SoloVPE instrument but 
packed separately. Attach the Strain Relief by screwing it onto the mating 
thread at the top of the SoloVPE instrument. 
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Step 8: Insert Delivery Fiber through Strain Relief 

Insert the Delivery Fiber through the Strain Relief to properly connect it to the 
SoloVPE Translation Stage. This step should be performed with the protective 
plastic cap in place over the FC end of the Delivery Fiber.  
The SoloVPE Delivery Fiber has two different connectors: an SMA connector 
with a hex-shaped nut and an FC connector with a keyed connector with a 
round knurled nut. The FC connector should be inserted into the SoloVPE 
instrument and the SMA end is for the Cary 60/Coupler side. 

 

Step 9: Slide SoloVPE Cover into Down Position  

To make the Delivery Fiber FC connection to the SoloVPE instrument, the 
Tower Cover must be slid into the down position. 

 

Step 10: Connect Delivery Fiber to Translation Stage  

The FC Connector is a keyed connection that  can only be securely attached 
when aligned properly. Rotate the Delivery Fiber to line up the notch on the FC 
connector and the keyway on the Translation Stage. Fully insert the FC 
connector and tighten the knurled nut securely.  
 
Note: When rotating the FC connector to align the notch, the entire Delivery 

Fiber will need to rotate. It is recommended that the FC connector be 
held with one hand as the Delivery Fiber is rotated with a free hand 
through the top of the Strain Relief. 

Notch 
Keyway 
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Step 11: Pass the Cables into the Cary 60  

Pass the Detector Cable (black, right-angle plug end) and the Delivery Fiber 
(SMA/hex-nut end) into the sample compartment through the now open 
sample compartment access port at the rear of the Cary 60. 

 

Step 12: Connect Detector Cable to Cary 60 

Remove the Cary 60 sample compartment covers. 
 
Connect the black, right-angle plug of the Detector Cable  into the Cary 60. On 
the wall of the Cary 60 sample compartment, there are two connection ports: 
when using the onboard detector (cuvette option), the black plug that resides 
in the sample compartment is connected. When using the SoloVPE instrument, 
the onboard detector is unplugged and the SoloVPE detector is plugged in.  

 

Step 13: Install Fiber Optic Coupler (FOC) into Cary 60  

Position the FOC above the two raised pins in the base of the sample 
compartment and lower into place, making sure it connects securely. 
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Step 14: Secure Fiber Optic Coupler Within Cary 60 

Using the large thumbscrew in its baseplate, secure the FOC to the base of the 
sample compartment. Tighten securely to prevent shifting. 

 

Step 15: Connect Delivery Fiber to Fiber Optic Coupler 

With the FOC installed, uncap the Delivery Fiber already present in the sample 
compartment and connect the SMA end of the Delivery Fiber to the threaded 
splice bushing at the back of the FOC. Use the hex nut to securely tighten the 
connection. 
 
Note: The alignment procedure must be followed in the Dual Use Fiber Optic 

Coupler User Manual DOC0047 to maximize transmission through the 
Fiber Optic Coupler. 

 

Step 16: Reinstall Cary 60 Sample Compartment Top Cover 

Carefully slide the Cary 60 sample compartment top cover back into place. 
Slide the cover back far enough to allow installation of the sample 
compartment front cover. 
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Step 17: Reinstall Cary 60 Sample Compartment Front Cover 

Position and slide the sample compartment cover down into place. Once fully 
inserted, reposition the top cover to close the compartment. 

 

Step 18: Connect Power Cable to Cary 60 

Connect the power cord (supplied with the Cary 60) to the back of the Cary 60. 
The transformer has a separate cord that runs to the wall outlet to allow for 
various power connectors. 

 

Step 19: Connect USB Cable to Cary 60  

Connect the USB Cable that came with the Cary 60 to the back panel of the 
Cary 60.  
 
Note: Do not connect the opposite end of the computer until directed to do so. 
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Step 20: Power on Computer  

Press the Power button on the computer to turn it on. 

 

Step 21: Follow Manual Directions to Install All Software 

Installation of the SoloVPE and Agilent software should only be done by a 
trained Support Specialist or under their guidance. While logged into  the 
computer with administrator privileges, install the Agilent Cary WinUV 
software and the SoloVPE software. 

 

Step 22: Power on Cary 60  

With the USB cable disconnected from the computer, press the Power button 
at the front of the Cary 60. Power up the Cary 60 and allow it to fully initialize. 
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Step 23: Allow Cary 60 to Complete Start-up Initialization 

When the Cary 60 is powered on, the hardware will initialize and calibrate, and 
the Power button  will light up and flash an orange color. After pressing the 
Power button to turn on the Cary 60, wait for it to turn green. A steady green 
light means the Cary 60 has initiated successfully.    
 
Note: If the System fails to initialize and calibrate successfully, the Power 

button will turn red. If it fails to start-up successfully, turn it off and turn 
it on again. 

 

Step 24: Connect USB Cable to Computer 

With the computer and Cary 60 powered up, make the final connection of the 
USB cable to the computer. The computer will audibly acknowledge that a USB 
device was connected and automatically detect and install the drivers for the 
Cary 60.  
 

Congratulations! 
The SoloVPE System is ready for use! 
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4. The CTech™ SoloVPE® System 

This section provides detailed step-by-step instructions for the most commonly used features and functions of the SoloVPE System. 
The procedures include guidance on the proper use of the hardware and the software, as well as expectations and limitations of the 
System. 
 
For more instruction on proper care, refer to CTech SoloVPE Best Practices DOC0153 and VPT Support: SoloVPE Service Options 
DOC0157 provided with the system.  
 

 
 
4.1 Fibrette® Optical Components 

The variable pathlength capability relies on the use of a light-transmitting component that moves in the sample solution, thus 
adjusting the pathlength. To reduce the risk of carryover and the time between measurements, the SoloVPE System has been 
designed to use disposable fiber optics called Fibrette Optical Components.  
 
4.1.1 How to Clean Optical Surfaces of Fibrette Optical Component 

*Warning: Repligen strongly recommends that Fibrette Optical Components only be used once to avoid the risk of measurement 
errors associated with improper cleaning and storage, damage, or carryover. This procedure is provided strictly for support of 
noncritical, academic, and non-GxP implementations for which measurement accuracy tolerances have been deemed less 
critical. 

 
1. After each use of a Fibrette Optical Component, store them in distilled water in a neoprene tube or a soft container to keep 

them wet.  
• Fibrette Optical Component must soak for a minimum of 30 minutes, but no longer than 24 hours. 
• Soaking longer than 24 hours can damage the polyamide coating.  
• Do not soak too many Fibrette Optical Components in a container; otherwise, they will clump together. 

2. At the end of the day, properly dispose of the water and fill the tube with cleaning reagent (e.g., IPA, methanol, or ethanol) 
and let it soak for 2 to 5 minutes.  

3. Pour out the solution and lay Fibrette Optical Component out on a paper towel to dry.  
4. Wipe entire length of Fibrette Optical Component with a lint-free wipe. Then spin both ends on a folded lint-free wipe. 
5. Place the Fibrette Optical Component back in the clean tube for future use. 

  
4.2 Proper Cover Use 

When taking measurements, the Tower Cover must always be in the closed position to avoid issues with ambient light. While the 
Cary 60 is substantially immune to the effects of room light, the presence of the Tower Cover improves stability, while at the same 
time protects users from the motion of the SoloVPE hardware as it changes pathlengths. When the cover is raised, the Fibrette 
Optical Component can be loaded and unloaded into the Fibrette Coupler.  
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4.3 SoloVPE TBA Fibrette Coupler 

 
The TBA Fibrette Coupler is the original version of the Fibrette Coupler (originally called the Legacy Fibrette Coupler). 

• Requires a manual pulldown of the Fibrette Optical Component for data acquisition 
• Replacement recommended every 6 to 12 months 

 
TBA Coupler Reusability 

The TBA Fibrette Couplers are not single-use items. Depending on the frequency of use, it is recommended that TBA Fibrette 
Couplers be replaced every 6 to 12 months. 
 
4.3.1 How to Remove TBA Fibrette Coupler Insert  

Before installation and removal of TBA Fibrette Couplers, it is best to get assistance from a Repligen analytical representative. A TBA 
Fibrette Coupler has a blue back end and a transparent, tapered tip. The Fibrette Coupler is installed into the SoloVPE stage using 
the Luer thread on the blue back end.  
 

1. Grasp the blue barrel of the Fibrette Coupler between the thumb and index finger and rotate it clockwise to unthread the 
unit from the mounting hole. One half to one full rotation will fully disengage the threaded portion of the Fibrette Coupler.  

2. Once the thread has disengaged, gently pull the Fibrette Coupler straight down and out of the mounting hole.  
  

 
Figure 6. TBA Coupler with Fibrette Optical Component inserted. 

 
4.3.2 How to Install TBA Fibrette Coupler Insert  

1. Hold the blue barrel of the Fibrette Coupler between the thumb and index finger with the blue back end of the Fibrette 
Coupler pointing up. Position the Fibrette Coupler below the SoloVPE stage to fit within the tapered mounting hole.  

2. Insert the Fibrette Coupler up into the mounting hole.  
Note: The mounting system is designed to have a tight fit, so there will be a feeling of resistance as it is pushed into the 

mounting hole.  
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3. Next, gently rotate the Fibrette Coupler counterclockwise to engage the Luer thread and rotate until the Fibrette Coupler 
has been drawn fully into the mounting hole and is flush with the Translation Stage. This requires approximately one-half 
rotation (180°).  

4. Finger tighten only. Do not overtighten. 
 
4.3.3 How to Load the TBA Fibrette Coupler 

1. Avoid touching the tip of the Fibrette Optical Component. 
2. Gently push the Fibrette Optical Component upward until it stops against the surface of the Delivery Fiber. 
3. To set, pull Fibrette Optical Component down slightly. 

• The distance between the Fibrette Optical Component and the Delivery Fiber should be between 2–10 mm. 
 

Note: It is critical for proper functioning of the hardware and sample measurement that the Fibrette Optical Component be pulled 
down after being inserted fully. 

 

   

   
4.4 SoloVPE Quick Set Fibrette Coupler  

 
The Quick Set Fibrette Coupler enables a highly repeatable method for preparing the Fibrette Optical Component for data 
acquisition. 

• Allows consistent Fibrette Optical Component positioning 
• Low maintenance: Replaced during annual PM service by VPT Support Specialist 

 
Quick Set Coupler Reusability:  

For upgrade installation of the new Quick Set Fibrette Coupler, please contact Repligen analytical representative for assistance. 
Quick Set Fibrette Couplers are not single-use items. It is not necessary to change this coupler frequently. 
  

2–10 mm 

Figure 7. Insert Fibrette Optical 
Component (TBA). 

Figure 8. Lower Fibrette Optical 
Component (TBA). 
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Figure 9. Quick Set Coupler with Fibrette Optical Component inserted. 

 
4.4.1 How to Remove Quick Set Fibrette Coupler Insert 

Before initial installation or removal of a Quick Set Fibrette Coupler Insert, it is best to get assistance from a Repligen analytical 
support specialist. 
 

1. Raise the Tower Cover of the SoloVPE instrument to view the Quick Set Fibrette Coupler Insert.  
2. With your thumb and index finger, grip the black Quick Set Fibrette Coupler Insert Holder. 
3. You will see its octagonal shape. 
4. Rotate the Holder clockwise until it becomes free from the Translation Stage, as shown in Figure 10. 

 

 
Figure 10. Removing Quick Set Fibrette Coupler. 

5. Push the insert up through the Holder for removal, keeping the white O-ring in place. Their connection is magnetized, so 
there will be some resistance (see Figure 11 and 12). 

 

    

  
 

Figure 11. Push Quick Set Fibrette 
Coupler Insert.  

Figure 12. White O-ring. 
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4.4.2 How to Install Quick Set Fibrette Coupler Insert 

1. To install a new Quick Set Fibrette Coupler Insert, place the insert directly into the holder, passing the tip of the insert 
through the larger opening. You should feel the magnetization pull the insert into the holder.  

2. Place the holder back onto the Translation Stage of the SoloVPE instrument and rotate counterclockwise until fully secure.  
3. To ensure the Quick Set Fibrette Coupler Insert was installed properly, actuate the coupler a few times (as if loading a 

Fibrette Optical Component).  
4. You should feel the magnetization smoothly pull the insert back down, as you push up and let go. 

 

 
Figure 13. Actuate Quick Set Fibrette Coupler. 

  
4.4.3 How to Load the Quick Set Fibrette Coupler  

The unique design of the Quick Set Fibrette Coupler eliminates the need for setting or pulling the Fibrette Optical Component down. 
The Quick Set Fibrette Coupler will automatically set the distance of the Fibrette Optical Component for the user. 
 

 

Step 1: Load the Fibrette Optical Component 

To load the Fibrette Optical Component into the Quick Set Coupler, gently push the 
Fibrette Optical Component fully upward until it stops against the surface of the 
Delivery Fiber. 

 

Step 2: Push Up Against Quick Set Coupler 

Push up against the Quick Set Coupler insert until it stops. An audible click may be 
heard. 
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Step 3: Engaging the Quick Set Coupler 

Release the Quick Set Coupler Insert to set the Fibrette Optical Component gap in 
preparation for sample acquisition. 

 
4.5 How to Clean Delivery Fiber Surfaces   

1. Delivery Fiber must be disconnected from the SoloVPE System. 
2. To disconnect the Delivery Fiber, unscrew the connector and pull straight up through the Strain Relief to remove the fiber 

end from the transport mechanism. 
3. Fold a lint-free wipe and firmly wipe the fiber connector surface in one direction. Repeat a few times. 
4. Spray compressed air over connector surface.  
5. If residue persists, add cleaning reagent to a lint-free wipe. Wipe the fiber optic surface in one direction until the residue is 

removed. See weekly actions in CTech SoloVPE Best Practices DOC0153. 
6. Repeat if necessary. 
7. Reconnect Delivery Fiber, making sure the connector key is properly positioned in the Delivery Fiber. Mount and tighten by 

turning the nut clockwise (see Figure 14). 
 

 
Figure 14. Reconnect Delivery Fiber to Translation Stage. 

 
4.6 Sample Vessels and Sample Vessel Holders 

The following section will explain the proper use of both plastic and fused silica sample vessels, sample vessel holders, and their 
specifications and best practices. Reference this section when identifying which vessel to use for samples of certain concentrations 
and types and their recommended volumes. 
 
4.6.1 Fused Silica Sample Vessels  

The system ships with three styles of fused silica sample vessels and the sample vessel holders required to use them. The three 
sample vessels provided are the large, small, and micro sizes. Each sample vessel has an associated maximum vessel pathlength and 
volume requirements based upon its geometry. Figure 9 provides information to help users choose the appropriate vessel for their 
application. Repligen does not recommend reuse of sample vessels. If you do wish to reuse a sample vessel, please follow the steps 
for proper cleaning listed in CTech SoloVPE Best Practices DOC0153. 
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4.6.2 Standard Vessel Data 

Table 3. Table of recommended volumes of standard vessels 

*The volumes listed cover the maximum pathlength of the vessel. Large vessels are typically used to measure dilute samples of 0.1 mg/ml or less. 
 
Each sample vessel must be used with the correct sample vessel holder. The holder securely positions the sample vessel properly in 
the SoloVPE System for measurement. The large and small/micro Vessel Holders are included with every new SoloVPE System sold. 
 
4.6.3 Plastic Sample Vessels 

In addition to the fused silica vessels, Repligen’s Analytics business unit provides OC0009-1 small disposable UV-grade plastic vessels.  
 
Plastic vessels can be used across a broad wavelength range (220 nm to 800 nm) while providing excellent resistance to a wide 
variety of chemical species. The UV plastic vessel fits into the existing micro/small Vessel Holder and the volume requirements are 
the same as the small fused silica vessel. Samples can also be retrieved prior to disposing of vessel, if desired. 
 
Table 4. Plastic vessel physical properties 

 
4.7 How to Handle Hardware and Maintenance 

The following section contains excerpts from CTech SoloVPE Best Practices DOC0153 for basic System scheduled maintenance.  
 

System Maintenance Checklist 

 Daily Weekly Monthly Biannually 

Quick Check Test 
    

Clean Fibrette® Optical Components & 
Fused Silica Vessels     

Clean Delivery Fiber   
   

Vessel Size Concentration Range Sample Type Volume 

Micro 
Max pathlength 5 mm 0.1 mg/ml to 330 mg/ml Antibody/Protein 60 µl 

Small 
Max pathlength 5 mm 0.1 mg/ml to 330 mg/ml Antibody/Protein 120 µl 

Large 
Max pathlength 15 mm 0.1 mg/ml or less* Antibody/Protein 2.5 ml 

Required Volume at Max 
Pathlength (5 mm) Pathlength Range Shelf Life Wavelength Range 

120 µm 0.005 mm–5.0 mm 18 months 120 µm 



  

 

 
 29 
DOC0126 eRev. 11/17/2023 11/17/2023   

User Guide CTech™ SoloVPE® System (V3 Software) 

Restart Cary Spectrophotometer   
   

Run Standard Test     
  

Coupler Check (V3/ViPER® only)     
  

Biannual System PM (CT)       
 

 
System Maintenance Guidelines 

Quick Check Test Cleaning Delivery Fiber (SoloVPE Instrument) 

Perform with a new Fibrette Optical Component. 
V2 Passing Criteria: %T at 35.00% or greater.  
V3/ViPER Passing Criteria: %T at 70.00% or greater. 

See corresponding section in the SoloVPE User Manual for 
cleaning of Delivery Fiber surfaces. 

 
• Disconnect Delivery Fiber from SoloVPE instrument by 

turning the nut counterclockwise. 
• Fold a lint-free wipe and firmly wipe the fiber 

connector surface in one direction a 3–5 times. 
• Use compressed air over connector surface (optional). 
• Reconnect Delivery Fiber, making sure the notch is 

properly positioned in the fiber platform, and tighten  
the nut by turning clockwise. 

 

 
 

• With no vessel and no vessel holder installed, blow 
compressed air across the Detector Window in the 
sample platform. Clean with a lint-free wipe if 
necessary. 

Fibrette Optical Components (only if cleaning) 

After each use of a Fibrette Optical Component, store in distilled 
water in a small beaker or neoprene tube to keep them wet 
(minimum 30 minutes). Fibrette Optical Components are not to 
be stored in water for longer than one day.  
 
Note: Do not soak too many Fibrette Optical Components in a 

container, otherwise they will clump together. 
 

• At the end of the day, pour out water and fill tube with 
IPA, Methanol, or Ethanol, and let is soak for 2–5 
minutes. 

• Pour out solution and lay Fibrette Optical Components 
out on paper towel to dry. 

• Wipe entire length of Fibrette Optical Component with 
a lint-free wipe then spin both ends on a folded lint-
free wipe. 

• Place the Fibrette Optical Component back in the clean 
tube for future use. 

Fused Silica Sample Vessels 

Clean after each use. Follow current procedures for fused silica 
sample vessel cleaning. Water rinse followed by cleaning agent 

(IPA, Methanol, or Ethanol). Rinse, then air dry or spray with 
compressed air. 

Cary Spectrophotometer Run System Suitability Standard Test 

Restart the Cary once a week. This is recommended by Repligen 
for consistent performance. 

Run provided CHEM013 standard, ConfiRM®, or the current UV 
standard (e.g., NIST reference standard). 

Coupler Check (V3 only) Annual System PM & Service Contract 

Run a Coupler Check after cleaning Delivery Fiber. Both services provided by Repligen. 
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5. Starting and Understanding the SoloVPE Software Environment  

 

After the SoloVPE software is installed, an icon will appear in the Start menu. The software can be launched by 
navigating to Start > All Programs > C Technologies > SoloVPE Software.  

  
The SoloVPE software was developed to integrate with the Cary WinUV software suite. For individuals with experience using the 
Cary WinUV software, the SoloVPE control software will be very familiar. When the program starts, the ADL Shell application 
automatically opens, and the SoloVPE splash screen will be displayed as the SoloVPE environment is prepared. The start-up 
sequence initializes the Cary spectrophotometer and the SoloVPE hardware.  
 

 
Figure 15. Cary WinUV software system initialization window. 
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Figure 16. The SoloVPE Environment in the Cary WinUV ADL Shell. 

The major sections of the SoloVPE control software application window are described in detail below. When the software starts for 
the first time, it is beneficial to practice navigating around the screen, turning sections on and off under the View menu. This will 
help the user get a feel for the system so they can begin acquiring data and creating powerful methods that leverage the capabilities 
of the SoloVPE System and its variable pathlength technology.  
 
 Table 5. Sections of the SoloVPE control software application window 

Element Name Description 

A Graphics 
Window 

The Graphics window is where data is displayed on graphs as traces. Users can display or 
hide the Graphics window by toggling it on and off under the View menu. 

B SoloVPE Sidebar The SoloVPE sidebar is a collection of buttons that provide the user access to the SoloVPE 
instrument. 

C Report Window The Report window is the destination for collected and reported data and information. 

D Cary WinUV 
Menubar 

The Cary WinUV menubar provides the user access to the Cary WinUV software 
functionality typically integrated with the computer’s operating system. 

E Cary WinUV 
Toolbar 

The Cary WinUV toolbar provides the user access to the functions required to manipulate 
the Graphics window, including the ability to configure which traces are visible and their 
appearance. 

F Status Bar The Status bar provides basic information regarding the status of the hardware and 
software. 

 A 
 B 

 D 

 E 

 F 

 C  G 

 H 
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G Status Window The Status window can be toggled on and off in several of the SoloVPE software modules 
and provides more detailed information about the status of the hardware and software. 

H SoloVPE Toolbar The SoloVPE toolbar is a collection of buttons that provide the user access to both the 
core capabilities of the SoloVPE System as well as new tools and utilities. 

 
5.1 The SoloVPE Sidebar 

The SoloVPE sidebar is the primary way users interact with the SoloVPE System. The sidebar consists of user command buttons, 
which allow access to specific features and applications in the SoloVPE software.  
 
Table 6. SoloVPE software sidebar functions 

Button Function 

 

Moves the Translation Stage to the Home position. 

 

Clears Graphics & Report windows, removes existing data and prompts system for new 
measurement. 

 

Prompts the user to enter a file name to save data. 

 

Opens the SoloVPE Manual Controls window. 

 

Tool for wavelength characterization. 

 

Tool for making rapid concentration measurements. 

 

An xy data set made up of absorbance data as a function of pathlength at a fixed wavelength. 

 

Tools for performing regression analysis on data. 

 

Tools for customizing and generating reports on data. 

 

Opens the Extinction Coefficient Library. 

 

Protected administrative control panel for the SoloVPE System. 

 
Depending on user permissions and access levels, Sidebar buttons can be enabled or disabled for use. This is managed using the 
SecureVPE software. For more information on SecureVPE, please reference the SecureVPE User Manual. 
 
5.2 The SoloVPE Toolbar 

The SoloVPE toolbar, similar to the SoloVPE sidebar, provides access to various features and functions for the system, and can be an 
additional way to access features already available in the sidebar.  
 
The following information presents the various icons available on the SoloVPE toolbar and provides a brief description of the 
function they provide.  
 
Table 7. SoloVPE software toolbar functions. 
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Button Name Function 

 

Slope Tool Quick regression tool: A simplified version of the Analyze screen. 

 

Factor Scale Scales the selected graph based upon the currently selected trace from 0 to the Max 
Value multiplied by a factor. 

 

Clear Rectangles Clears background rectangles from the selected graph. 

 

Volume Pathlength 
Estimator 

Opens a tool capable of converting pathlength and volume values for specific vessel 
sizes. For a more in-depth explanation on how to use this function, refer to Section 5.8. 

 

Quick Check Opens the Quick Check Diagnostics Utility tool. Allows for a system health check by 
making a series of transmission measurements. 

 

Auto Arrange Graphs 
Horizontal—Bottom 

The user has the capability to change the arrangement of a selected graph to make it 
the focal point.   
The yellow region represents the user-selected graph.  
The gray regions represent the unselected graphs. 

 

Auto Arrange Graphs 
Horizontal—Top 

The user has the capability to change the arrangement of a selected graph to make it 
the focal point. 
The yellow region represents the user-selected graph. 
The gray regions represent the unselected graphs. 

 

Auto Arrange Graphs 
Horizontal—Left 

The user has the capability to change the arrangement of a selected graph to make it 
the focal point. 
The yellow region represents the user-selected graph.  
The gray regions represent the unselected graphs. 

 

Auto Arrange Graphs 
Horizontal—Right 

The user has the capability to change the arrangement of a selected graph to make it 
the focal point.  
The yellow region represents the user-selected graph.  
The gray regions represent the unselected graphs. 

 
5.3 The Quick Utilities: Quick Tools 

One of the fastest ways to begin using the SoloVPE System and collecting data is to use the library of Quick Utilities. The Quick 
Utilities are simple, self-contained applications designed to let users collect useful data quickly with little configuration. They allow 
access to the core capabilities of the SoloVPE System with short learning curves, and produce the most commonly desired results 
with relatively little lead time.  
 
SoloVPE Toolbar Exists Within the Cary WinUV Toolbar: It is important to note that the toolbar is an element within the Graphics 
pane of the ADL Shell environment. If the Graphics pane mode is not visible using the View menu, the toolbar will disappear. It will 
return when the Graphics pane is made visible again. 
  
5.3.1 Quick Survey 

When needing to characterize an unknown sample, Quick Survey enables users to collect spectra at various pathlengths. This 
provides insight into the location of wavelength peaks and the pathlength ranges at which they can be resolved. Quick Survey 
accomplishes this with the greatest simplicity, requiring the user to provide only a sample name and the sample vessel being used. 
Within the software, there exists options to perform baseline correction, and the Advanced Settings button gives users access to 
customization options for pathlengths and wavelength settings. The following procedure explains how to use this utility. 
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Figure 17. Quick Tool: Quick Survey window. 

Perform Simple Measurements with Quick Survey 

Quick Survey collects spectra across a wide wavelength range, at various pathlengths with the specified sample vessel. For unknown 
samples, it is best to fill the sample vessel with adequate solution to avoid having the Fibrette Optical Component come out of the 
sample. 
 

1. Click the Quick Survey button on the SoloVPE sidebar to start. 
2. Type a sample name into the field provided. 
3. Select the sample vessel that is being used. 
4. Click the Start Collect button and the system will prompt the user to load a sample and a new Fibrette Optical Component.   
5. Click OK when ready. 

 
Perform Simple Quick Survey Correction 

The baseline data must be collected prior to measuring the sample solution. For unknown samples, it is best to fill the sample vessel 
with adequate solution to avoid having the Fibrette Optical Component come out of the sample. 
 

1. Click the Quick Survey button on the SoloVPE sidebar to start. 
2. Type a sample name into the field provided. 
3. Select the sample vessel that is being used. 
4. Enable baseline correction by selecting ON from the Baseline control. The Baseline button will be enabled. 
5. Click the Baseline button to initiate collection of the background data. The system will prompt the user to load a 

background solution and a new Fibrette Optical Component.  
6. Click OK when ready. 
7. After the baseline collection is complete, click the Start Collect button and the system will prompt the user to load a 

sample.  
8. Click OK when ready. 

 
Perform Advanced Measurements with Quick Survey 

The Quick Survey settings including the wavelength ranges, Cary settings, and pathlengths to be acquired. Quick Survey will then 
collect the user-specified wavelength range at the user-specified pathlengths. The user should ensure that they dispense enough 
sample to cover the desired pathlength range. 
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1. Click the Quick Survey button on the SoloVPE sidebar to start the Quick Tool.  
2. Type a sample name into the Sample Name field provided. 
3. Select the sample vessel that is being used. 
4. Click the Advanced Settings to open the configuration window (see Figure 18). 

 

 
Figure 18. The Advanced Quick Survey Settings window.  

5. Modify the Advanced Settings by: 
• Threshold Search Pathlengths 

⇒ Enable or disable specific pathlengths 
⇒ Manually set pathlengths 

• Cary settings 
⇒ Scan Start/Stop 
⇒ Average Time 
⇒ Data Interval 

• Other settings 
⇒ Display options for data 
⇒ Autosave enables/disables the option to save 
⇒ Toggling the Print Graphics Region on and off allows the user to display the graph in the report. 

6. To restore default values, click the Defaults button. 
7. Click Save to keep the changes or Cancel to abandon them. 
8. Click the Start Collect button and the system will prompt the user to load a sample and a new Fibrette Optical Component.   
9. Click OK when ready. 

 
Perform Advanced Quick Survey Correction 

As previously stated, the Quick Survey settings include the scan ranges, Cary settings, and pathlengths to be acquired. With Quick 
Survey Correction, users can perform baseline correction. The baseline data must be acquired prior to collecting data on the sample 
solution.  
 
As with Quick Survey Advanced Measurements, Quick Survey Correction then collects the user-specified wavelength range at the 
user-specified pathlengths. The user should be sure to dispense enough sample to cover the desired pathlength range. 
 

1. Follow Steps 1–5 in “Perform Advanced Measurements with Quick Survey” (in this Section). 
2. Click the Baseline button to initiate collection of the background data. 

• The system prompts the user to load background solution and a new Fibrette Optical Component. 
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3. Click OK when ready. 
4. After the baseline collection is complete, click the Start Collect button and the system will prompt the user to load the 

sample. 
5. Click OK when ready.  

 

 
Figure 19. “Collection Complete?” prompt. 

The “Collection Complete?” Prompt: After data acquisition has occurred and the user selects Done from the Quick Survey window, 
the software will prompt the user (see Figure 19) to either send the Fibrette Optical Component to the Home position or send the 
Fibrette Optical Component to the Zero Pathlength position for additional measurements. 
 
This feature is useful for uninterrupted data collection and analysis. By selecting No to Send Fibrette Home?, the user can 
immediately move from Quick Survey data collection to Quick Slope data collection. 
  
5.3.2 Quick Slope 

Quick Slope is made possible by the variable pathlength Slope Spectroscopy. This utilizes the slope of absorbance vs. pathlength 
curves to make calculations and determinations of variables such as concentration and extinction coefficients (EC). The SoloVPE 
System enables the development of methods to control the SoloVPE and the Cary instruments so they can generate slope data over 
various wavelength and pathlength ranges.  
 
Quick Slope was developed to enable users to place a sample in the device, and rapidly determine concentration by using the slope 
of the section (absorbance vs. pathlength) curve and a user-supplied extinction coefficient. This is especially useful in finding the 
linear region of highly concentrated samples.  
 
There are several options that can be selected while running a sample, which can be found on the various menus outlined in Figure 
20. 



  

 

 
 37 
DOC0126 eRev. 11/17/2023 11/17/2023   

User Guide CTech™ SoloVPE® System (V3 Software) 

 
Figure 20. Quick Tool: Quick Slope window. 

 
5.3.3 Quick Methods 

Quick Methods are templates that allow users to select a starting point from which to work. The addition of Quick Methods gives 
users the ability to choose from predefined configurations. It should be noted that this feature can be disabled with the SecureVPE 
software. 
 
Table 8. List of Quick Tool Slope Modes. 

Name Description 

None This setting allows the user to input any value. All fields can be modified when this mode is selected.  

Standard Quick 
Slope 

This method preselects 280 nm as the wavelength and Quick-M for the slope mode. 

Fixed Slope This method allows the user to specifically define a starting pathlength, the pathlength step size, and the 
number of data points to be acquired. It then collects the section data according to the defined method and 
reports the slope value.  
The Slope Mode will automatically change to Fixed-M if Fixed Slope Example is selected.  

Multi Quick 
Slope 

This method allows the user to perform multiple runs with a single sample. The runs can be performed at 
multiple wavelengths, reducing the downtime between runs.  
The Slope Mode will automatically change to MultiQ-M if Multi Quick Slope Example is selected.  

 
5.3.4 Slope Mode 

This tool allows users to choose different types of slope modes for their measurements. 
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Table 9. List of Quick Tool Slope Modes. 

Name Description 

Quick-M This setting allows the user to input any value. All fields can be modified when this mode is selected.  

Fixed-M Unlike Quick Slope, Fixed Slope does not perform an initial search or characterization of the sample. There is 
no target absorbance value and thus no threshold pathlength identified.  

Instead, the user must specifically define a starting pathlength, the pathlength step size, and the number of 
data points to be acquired. It then collects the section data according to the defined method and reports the 
slope value. 

Multi-Quick 
Slope Mode 
(Multi Q-M) 

Multi-Quick Slope uses the same parameters as Quick Slope but has been designed to perform the initial 
search and characterization at multiple wavelengths in a way that eliminates having to run multiple, single 
Quick Slopes.  
It has been designed to create a path to more advanced methods that may include deeper analysis, such as 
ratios and other more complex calculations. These can be performed as part of the method instead of 
through post-acquisition processing. 

 
5.3.5 Method Files 

A saved Method can be opened by selecting Open Method from the Quick Tool: Quick Slope window (see Figure 20). An alternative 
to saving, creating, or opening a Method is to input the parameter within Quick Slope and, once completed, go to File > Save 
Method As (.MVP) and save to the desired location. To open the method file, go to File > Open Method or drag and drop the Method 
File into the ADL Shell window.  
  
5.3.6 User Results 

This function, accessible via the field at the bottom of the Quick Slope window, allows users to build and process equations through 
use of its calculator pop-up. The software creates variables that represent the slopes at various wavelengths. Once the data is 
acquired, any calculation that was performed will display in the Reporting window.  
  
5.3.7 Method Details 

Once the user inputs the parameters necessary to run the method, it can be saved by navigating to File > Save Method As (.MVP) 
and save to the desired location. To open the method file, go to File > Open Method. It can be dragged and dropped into the ADL 
Shell window. Method Details are a function used to help guide users through method development. 
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Figure 21. Save a Method file. 

 
5.3.8 Data Acquisition: DAQ Mode 

This mode allows for users to implement the method parameters for sample measurements with a restricted view. It should be 
noted that this mode is only available with the SecureVPE. 
  
5.3.9 Reps 

With the Reps feature, Quick Slope immediately reports results and keeps the Fibrette Optical Component in the sample as it waits 
for further instructions. These Reps functions have been modified for greater user control. There are different types of Reps modes 
available. 
 
5.3.10 User Specified Pass/Fail Criteria 

This tool allows the user to enter the expected value and pass/fail tolerance for the current measurement. By clicking the ellipses, 
the user can change the minimum number of datapoints required and the tolerance metric from absolute units to percentage. The 
tolerance and expected value must be defined prior to testing.  
 
Note: It is not recommended that the number of data points be changed from the default setting of 5.  
 
No Baseline Correction! 

Slope Spectroscopy is a very useful technique that enables users to create very powerful analysis methods. One of the unique and 
most popular features associated with Slope Spectroscopy is that baseline correction is often unnecessary. The two frequently asked 
questions are “Why?” and “When would this be the case?”.  
 
Why No Baseline? 

Why no baseline? Because Slope Spectroscopy relies on the change in absorbance associated with changes in pathlength, the 
absolute absorbance level does not matter. Only the rate of change matters (the slope).  
 
Figure 22 shows two plotted lines. The lower pink line is baseline corrected, and the upper blue line is not. The two lines are 
essentially parallel, which is another way of saying they have the same slope. If the slopes are equal, the concentrations calculated 
from those slopes will be equal; therefore, users can frequently save the time, effort, and resources associated with running the 
baseline. 
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Figure 22. No baseline correction required. 

When Are Baselines Required? 

There are times when baseline correction will still be required, but how does one know? Baselines are required when the 
background media absorbance scans show pathlength dependence, meaning the absorbance values change with pathlength. In 
terms of Section Data (absorbance vs. pathlength) the slope of a section plot will not be zero.  
 
This can be determined quickly during method development by scanning the background media and checking its slope. If the slope 
of the section curve does not equal zero, baseline correction is required. The SoloVPE Software performs this check and will indicate 
if baseline correction is required during some methods. 
 
Perform Quick Slope Measurements 

Click on the Quick Slope button displayed on the SoloVPE sidebar to open the Quick Slope window. 
 

1. Type a sample name in the Sample Name field provided. 
2. Select the sample vessel type. 
3. Type the method Wavelength at which to collect the Section/Slope.  
4. Select the appropriate extinction coefficient populated by the Extinction Coefficient Library or select User to enter a custom 

EC value. 
• For details on editing the Extinction Coefficient Library, see the “SoloVPE Toolbar: Extinction Coefficient Library” 

section in this manual. 
• If the value is left unselected at default, no concentration will be produced; however, a slope value will still be 

reported after data collection. 
5. Select any other options that need to be enabled or disabled such as baseline correction or scatter correction (if required). 
6. Select the option to enable the Pass/Fail Criteria (if required). If an EC Value is defined, the expected value will be the 

concentration. If an EC value is not defined, the expected value will be the Slope. The predefined tolerance should be put 
into the Abs/mm field. 

7. Click the Set Method button to accept the changes made in Quick Slope. 
8. Once the system has been prepared for Quick Slope, the Start Collect button will illuminate for data acquisition. 
9. Click the Start Collect button and the system will prompt the user to load the sample and a new Fibrette Optical 

Component.   
10. Click OK when ready. 

 
The system will perform the Quick Slope collection routine and report the results in the Graphics pane, the Report pane, and the 
Quick Slope window. 
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Perform Fixed Slope Measurements 

1. Click on the Quick Slope button displayed on the SoloVPE sidebar to open the Quick Slope Utility window. 
2. Select the Slope Mode dropdown menu and select Fixed-M as the mode. 
3. Click the ellipsis button next to the Slope Mode menu (…). 

 

 
Figure 23. Fixed Slope Configuration window. 

4. Users may now customize their slope collection. 
a. Data points: The number of data points that will be collected. 
b. Start PL: The starting pathlength for data collection. 
c. Step PL: The number of steps the SoloVPE device will move between data points, starting with the Start PL.   
d. Collect Spectra: Takes a scan of the sample at each pathlength (optional and not commonly used). 
e. Avg. Time(s): How quickly the Cary 60 collects data. 

 

 
Figure 24. Spectra collect config-fixed slope window. 

5. Select the sample vessel type. 
6. Click Done to accept the new settings. 
7. Enter the Fixed Slope Wavelength(s). 

• Fixed-M can run multiple wavelengths.  
8. Select the appropriate extinction coefficient populated by the EC Library or select User to enter a custom EC value.  

• For details on editing the Extinction Coefficient Library, see the “SoloVPE Toolbar: Extinction Coefficient Library” in 
this manual. 

• If the value is left unselected at default, no concentration will be produced; however, a slope value will still be 
reported after data collection. 

9. Select any other options that need to be enabled or disabled such as baseline correction or scatter correction (if required). 
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10. Select the option to enable the Pass/Fail Criteria (if required). If an EC Value is defined, the expected value will be the 
concentration. If an EC value is not defined, the expected value will be the slope. The predefined tolerance should be put 
into the Abs/mm field. 

11. Click the Set Method button to accept the changes made in Quick Slope. 
12. Once the system has been prepared for Quick Slope, the Start Collect button will illuminate for data acquisition. 
13. Click the Start Collect button and the system will prompt the user to load the sample and a new Fibrette Optical 

Component.   
14. Click OK when ready. 

 
Perform MultiQ Quick Slope Measurements 

1. Click on the Quick Slope button displayed on the SoloVPE sidebar to open the Quick Slope window. 
2. Select the Slope Mode dropdown menu and choose Multi-M as the mode, as depicted in Figure 25. 

 

 
Figure 25. Quick Slope: Slope Mode dropdown menu. 

3. Select the sample vessel size. 
4. Enter the Multi-Quick Slope Wavelengths that will be analyzed.  
5. Select the appropriate extinction coefficient populated by the EC Library or select User to enter a custom EC value.  

• When using this option, the user will have the option of entering an extinction coefficient for each wavelength of 
interest. 

• If the value is left unselected at default, no concentration will be produced; however, a slope value will still be 
reported after data collection. 

6. Select any other options that need to be enabled or disabled such as baseline correction or scatter correction (if required). 
7. Select the option to enable the Pass/Fail Criteria (if required). If an EC Value is defined, the expected value will be the 

concentration. If an EC value is not defined, the expected value will be the Slope. The predefined tolerance should be put 
into the Abs/mm field. 

8. Click the Set Method button to accept the changes made in Quick Slope. 
9. Once the system has been prepared for Quick Slope, the Start Collect button will illuminate for data acquisition. 
10. Click the Start Collect button and the system will prompt the user to load the sample and a new Fibrette Optical 

Component.   
11. Click OK when ready. 

 
Perform Data Acquisition: DAQ Mode* 

*DAQ Mode is only accessible when the SecureVPE software is installed and enabled. 
 

 
Figure 26. Data acquisition (DAQ) window. 

1. Open Quick Slope from the SoloVPE sidebar button. 
2. DAQ View will appear (Figure 26). 
3. Open a stored Method File or select a predefined Quick Method from the dropdown menu. Users may check the 

parameters of the method by clicking the Method Details button. 
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4. Enter the Sample Name. 
5. Enter any additional information by clicking the ellipsis button (…). 
6. Prepare the SoloVPE System for a sample run. 
7. Click the Start Collect button to begin data acquisition. 
 

Quick Slope Advanced Setting Overview 

 
Figure 27. Quick Slope Advanced Settings window. 

• Autosave Enabled: Prompts the user to save the data. 
⇒ Incremental Autosave Enabled creates a trail of data that consistently saves the user data.  It adds a _1, _2, 

etc. to the data when it is saved. 
• Report Legacy Format: Reports the data in the format of older SoloVPE software versions.  
• Report Graphics Region: Prints only the graphics in the reporting window. 
• Insert Report Signature Line: Allows the user to input a Signature Line for the ability to get the report signed. 
• Report Method Details: Prints the Method Detail in the reporting window. 
• Report Tabular Data: Prints all Tabular Data in the report. 
• Insert Graph in Report: Inserts Graph in the reporting window. 

 
Click Done to save the changes or Cancel to abandon them.  
  
5.3.11 Quick Slope User Results Capability 

The User Result calculator allows mathematical expressions to be set up using slope values. For example, if a Multi-Q Quick Slope 
measurement is being taken at two wavelengths, 280 nm and 310 nm, represented as [M1] and [M2] respectively, will be granted. 
As shown in Figure 29, these tokens appear in the Parameter List on the left side of the Setup User Result window.  
 
The user can then specify calculations to be made with the available tokens in the Setup User Results Expression field. Expressions 
can be entered with the keyboard or by using the available buttons in the menu (see Figure 26). This menu is opened by clicking the 
ellipsis  button next to User Results. The expression is then evaluated and reported with the slope measurements and other method 
details.  
 
Note: It is important to remember that all computations are made following the order of operations. Care must be taken to ensure 

proper configuration and syntax for long or complex calculations.  
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The Setup User Results window consists of the User Results Expression field, the Parameter List (that contains the user’s slope 
tokens), the Help Box, and several buttons defined below. 
 

• User Results Expression input: The user can input expressions that will be defined in the report after slope 
measurements are taken. A user can either use the available buttons or enter expressions using the keyboard. 
Expressions entered here will appear in the User Result field in the Quick Slope menu. 

• Slope Tokens: Slope tokens, which appear as [M1], [M2], etc., represent the slope of the impending run. They are 
selected from the Parameter List or typed directly into an expression field. If several wavelengths are set up to be 
measured, [M1] refers to the shortest wavelength with the following tokens being granted in ascending order. 

• Parameter List: This is where all available slope tokens appear. 
• Insert: The Insert button is used to insert selected slope tokens into the User Results Expression Input. 
• Help Box: The Help box displays information about select features in the Setup User Results window.  Also, selecting a 

slope token will display the associated wavelength. 
• Del: This tab deletes the last entered term in the User Results Expression field. 
• Clear: This tab clears the entire contents of the User Results Expression field. 
• Cancel: This tab closes the Setup User Results window without saving the expression entered in the User Results 

Expression input field. 
• Done: Clicking Done closes the Setup User Results window and saves the entered expression to the User Result field in 

the Quick Slope menu.  
 

 
Figure 28. SoloVPE Setup User Result window. 

Perform an M260/M280 Ratio Measurement with User Result 

This procedure describes how to perform an M260/M280 ratio measurement frequently used for nucleic acids using the User 
Results calculator. 
 

1. To perform this calculation, set up either a Fixed-M or MultiQ-M Quick Slope measurement in which slopes will be taken at 
both 260 nm and 280 nm. 

2. Next, open the Setup User Results window by clicking the ellipses button next to User Result in the Quick Slope window (…). 
3. The ratio expression can then be set up by selecting M1 in the Parameter List and clicking Insert, then the Divide button, 

selecting M2, and then clicking the Insert tab.  Alternatively, users can enter the expression by typing “[M1]/[M2]” into the 
Setup User Results input field. 
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4. Once the expression has been set up, click the Done button to confirm the expression and close the User Result window. 
5. The expression will now appear in the User Result field in the Quick Slope menu as shown in Figure 29. 

 

 
Figure 29. Quick Tool Quick Slope with user results. 

6. Click Set Method to confirm changes to the method. 
7. Click Start Collect. The results of the expression will be evaluated in the report as detailed in Figure 30. 

 

 
Figure 30. User Result report. 

Important Note About User Results Report Display: 

In the report, the User Result expression is displayed in the Quick Slope Method Details, after the words User Result. The result of 
the expression will be reported in the same line as the slope value, to the right of the Collect Time. Both expressions and result 
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display locations are highlighted in the picture above. It is important to note that the evaluation of the User Result will be reported 
in the line of the highest wavelength being measured. So, in the displayed example, the correct expression of the user result will be 
in the line for 280.00 nm. 
  
5.3.12 Understanding Quick Slope Indicators (Alerts and Messages) 

The SoloVPE software suite includes a software module called Quick Slope. The Quick Slope module is designed to make Slope-
Spectroscopy-based measurements on samples. Slope measurements are made by first finding a user-specified target absorbance 
value by analyzing the sample at a variety of pathlengths. The pathlength at which the target absorbance is found is referred to as 
the threshold pathlength. The Quick Slope algorithm then collects a number of data points (absorbance values at different 
pathlengths) and uses this data set to perform a regression analysis to provide slope and R2 values used for quantification.  
 
Quick Slope is an autonomous module and generally runs with minimal user intervention. However, when Quick Slope encounters 
certain conditions, it notifies the user of those conditions and the actions it took. The information below shows the indicator icon, 
name, and the description of the Quick Slope indicators. 
 

 No Baseline Required Indicator 
When: Displayed following the collection of a baseline section data which shows little-or-no slope. 
Why: This icon is displayed to notify the user that the slope of the baseline data set is very small and does not appear to display 
pathlength dependence. This is a notification to the user that baseline correction may not be necessary for this buffer or background 
media. It is strictly information for the user and does not impact the data or results. It is intended to alert the user in case the user 
wishes to investigate a non-baseline-corrected method. 
 

 Pathlength Shifted Down Indicator 
When: Displayed following the collection of Quick Slope section data, when the threshold pathlength is determined to be very long. 
Why: In a similar behavior to the Pathlength Shifted Up message, the Pathlength Shifted Down message is the corresponding 
notification of when a sample is found to be very dilute. In relation to the current sample vessel size being used, this message is 
displayed when the threshold pathlength at which the target absorbance is projected to occur is above the longest pathlength 
measurement possible.  
 
In a behavior that is consistent with the other extreme, Quick Slope collects absorbance data from the longest pathlength possible 
downward to show the user information that will assist them in subsequent measurements or continued data analysis. As is the case 
with highly concentrated samples, the software always works to show the user useful information.   
 

 Pathlength Shifted Up Indicator 
When: Displayed following the collection of Quick Slope section data when the threshold pathlength is determined to be very short. 
Why: Quick Slope first finds the threshold pathlength at which the target absorbance level is reached and then collects the specified 
number of data points starting at the threshold pathlength and moving downward to smaller pathlengths. Samples that are highly 
concentrated sometimes result in small threshold pathlengths being found. Sometimes, the threshold pathlength is so small that 
given the number of data points to be collected and the pathlength step size between those data points, Quick Slope finds that 
negative or impossible pathlengths are required.  
 
When Quick Slope sees this condition, rather than simply generating an error for the user, Quick Slope will collect the specified 
number of data points but “shifts” the pathlength range. This means that the smallest pathlength at which data is collected will be 
changed to correspond to the smallest pathlength the SoloVPE System is capable of measuring. Quick Slope will then collect upward 
from that point.  
 
By doing so, the longest pathlength at which data is collected no longer corresponds to the threshold pathlength; therefore, the 
absorbance values collected at the longer pathlengths will exceed the target absorbance level specified in the method. 
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The reason the message is displayed is to alert the user that Quick Slope has taken an action that is outside its default algorithm. This 
is done to make sure the user can examine the data (using Analyze in the Slope Tool) with that information in mind.  
 

 High Absorbance Indicator 
When: Displayed following the collection of Quick Slope section data, when the average absorbance of the section data exceeds the 
alert threshold. 
Why: This icon is displayed to notify the user that the collected section data displays a high average absorbance. The average 
absorbance of the section data set is calculated and compared to a default threshold (system defaults to 1.250 Au). This alert is 
displayed in conjunction with the Pathlength Shifted Up notification since a shift to longer pathlengths inherently results in higher 
absorbance values.  
 
This notification serves to inform the user that the sample conditions could be approaching the absorbance region where Beer’s law 
breaks down and nonlinear data can be present. These conditions will typically be confirmed by poor regression results, which are 
easily visualized when looking at the section plot or the Low R2 Indicator appears.  
 
The High Absorbance Indicator can also appear if there are contaminants in the optical path of the SoloVPE System, whose presence 
could cause the system to lose light. This loss of light may be indicated by  high absorbance levels. When the anticipated 
concentration seems inconsistent with the absorbance level, a good troubleshooting step is to clean the optical path (i.e., Fibrette 
Optical Component, Quick Set Coupler, Delivery Fiber). 
 

 Low Absorbance Indicator 
When: Displayed following the collection of Quick Slope section data, when the average absorbance of the section data is below the 
alert threshold. 
Why: This icon is displayed to notify the user that the section data collected by Quick Slope displays a low average absorbance. The 
average absorbance of the section data set is calculated and compared to a default threshold (system defaults to 0.100 Au). This 
alert will sometimes be displayed in conjunction with the Pathlength Shifted Down notification since the shift to longer pathlengths 
will typically occur when Quick Slope cannot reach the threshold pathlength required to find to the target absorbance value. This 
notification makes the user aware of conditions that may influence the measurement results. Conditions such as very dilute samples, 
absorbance levels that approach the detection level of the device, and slope resolutions that approach the limit of the device could 
all be influenced by very low absorbance levels. As is the case of high absorbance conditions, low absorbance conditions will also 
display poor regressions results and low R2 values, which may also result in the display of the Low R2 Indicator. 
 

 Low R2 Indicator 
When: Displayed following the collection of Quick Slope section data, when the regression statistics display R2 results that are below 
a set threshold (default of 0.999). 
Why: This icon is displayed to notify the user that the slope results have an R2 value that is below a desired level, which by default is 
0.999. This can occur for several reasons, including highly concentrated (high absorbance) samples, low concentrated (low 
absorbance) samples, data collected in the sample nonlinear range where Beer’s law breaks down, or the Fibrette Optical 
Component came out of the sample due to insufficient sample in the sample vessel. 
 
There are a number of steps users can take when this occurs. The simplest is to analyze the Quick Slope section data set with the 
Slope tool or Analyze tools and see if removing some of the extreme data points from the analysis changes the quality of the 
regression.  
 
There are times when the Quick Slope default of collecting ten data points results in a pathlength shift and introduces possible 
nonlinearity, but fewer data points will produce more consistent results. In these cases, the Analyze function within the Slope tool 
will allow users to work with the regressions to find the optimal ranges.  
 
Subsequent Quick Slope methods can then be created to target a lower target absorbance or specify fewer data points to be 
collected. 
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There are also times where contaminants in the optical path can affect the R2 values due to reduced transmissions. Cleaning the 
optical path and re-running the sample with a clean Fibrette Optical Component often resolves this issue. 
  
5.3.13 The Quick Check Test 

The Quick Check Test is a series of transmission measurements that provide instant feedback on the overall transmission and health 
of the SoloVPE instrument. The purpose of the Quick Check Test is to provide transmission checks and to ensure proper transmission 
through the Fibrette Optical Component is reaching the Detector of the SoloVPE instrument. Quick Checks are measured at different 
pathlengths, with the sample platform empty and the Fibrette Optical Component pushed fully upward to be in contact the Delivery 
Fiber*.  
 
The concept behind this test is to evaluate transmission, while limiting potential for light loss. While a Quick Check will not 
necessarily allow users to identify specific causes for a decrease in transmission, the software will alert the user of the need for 
corrective action or continued investigation. 
 
This Quick Utility should be incorporated into the organization’s standard operating procedures as a means of periodic verification of 
the health of the SoloVPE System. It is recommended that a Quick Check be performed daily while the SoloVPE System is in regular 
operation. 
 
As Quick Check tests are performed, the results accumulate in a log file to allow for review and analysis of past results. A default 
specification is used to disposition the transmission of the system. Only one of the four measurement results are used to disposition 
the transmission of the SoloVPE System, which is the percent transmission at 500 nm in the Zero Pathlength position.   
 
Quick Check has been enhanced to provide a unique baseline for individual SoloVPE Systems. The disposition/threshold percentage 
has been changed to consider this baseline and thus provide a level of standardization between different SoloVPE Systems. The 
ability to track transmission data trends has been expanded to give users greater control of information about their SoloVPE System. 
The introduction of the Coupler Check feature measures the transmission from the Cary spectrophotometer to the SoloVPE 
instrument. The Coupler Check transmission provides a  foundation for the baseline transmission for Quick Check to refer. The 
results from the Quick Check tests give users a clear summary of the result by using a pass/fail format. 
 
*Fibrette Optical Component Pushed Fully Upward for Quick Check Tests: Quick Check Tests must be run with the Fibrette Optical 

Component pushed fully upward to achieve optimal Fibrette Optical Component/Delivery Fiber coupling. This must be done 
without a sample vessel or sample vessel holder loaded in the sample platform. 

  
5.3.14 The Coupler Check Test 

The Coupler Check test conducts a transmission check using the Transmission Tool. The Coupler Check test establishes a baseline 
transmission reading for the SoloVPE System. This will also measure the maximum transmission of the system. Quick Check then 
takes a transmission reading and compares it with the Coupler Check results.  
 
The output displayed in the Quick Check window is the percentage transmission achieved using Coupler Check as the baseline. Users 
can confidently determine that their system is receiving acceptable overall transmission. 
 
5.3.15 Running a Coupler Check and Quick Check Test 

Run a Coupler Check Test 

This procedure describes how to perform a Coupler Check using the Quick Check Diagnostics Tool on the SoloVPE System. 
 

1. Click the Quick Check button on the SoloVPE Toolbar to start Quick Check, as seen in Figure 31. The Quick Check Diagnostic 
Check window will appear (see Figure 32). 
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Figure 31. Quick Check button on SoloVPE toolbar. 

 

 
Figure 32. Quick Check window before Coupler Check is performed. 

Note: The Quick Check button will be unavailable on the first run. A prompt will appear notifying the user that a Coupler Check must 
be performed before performing a Quick Check. 

 
2. Click the Coupler Check button to baseline the Quick Check Diagnostics Check. A prompt will appear with the instructions 

“Prepare Delivery Fiber for Coupler Check,” as seen in Figure 33. 
 

 
Figure 33. Prepare Delivery Fiber for Coupler Check window prompt. 

3. Follow the prompt by removing the Delivery Fiber from the Translation Stage by turning the FC connector end of the 
Delivery Fiber counter-clockwise (see Figure 34). Attach the FC end of the Delivery Fiber to the Transmission Tool and place 
both connected devices on top of the SoloVPE Detector Window. Be sure to align the notch on the Delivery Fiber to the 
keyway on the Transmission Tool (refer to Figures 35 and 36). 

 



  

 

 
 50 
DOC0126 eRev. 11/17/2023 11/17/2023   

User Guide CTech™ SoloVPE® System (V3 Software) 

 
Figure 34. Disconnect Delivery Fiber from Translation Stage. 

 

 

    
 

4. Click OK on the prompt window when ready. The Coupler Check will then be performed. 
5. The results are displayed in the bottom left corner of the Quick Check Diagnostic Check window (see Figure 37). The user 

must visually analyze the result before moving on to Quick Check. 
 

Notch 

Keyway 

Figure 35. Connect Delivery Fiber to 
Transmission Tool. 

Figure 36. Connect Transmission Tool 
to Translation Stage. 
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Figure 37. Quick Check Diagnostic Check window with Coupler Check results. 

6. The system will assess a change threshold check to determine if the system requires cleaning. This setting is configured 
within the Advanced menu of SoloVPE Quick Check Diagnostic Check. The default is set to 12.00%. 

• If the Coupler Check fails and returns a result that surpasses the threshold, a prompt recommending a system 
clean will appear. Perform the Daily and Weekly Maintenance Best Practices and retry the Coupler Check once 
completed. 

7. Remove the Delivery Fiber from the SoloVPE instrument and detach the Fiber from the Transmission Tool. 
8. Re-insert the Delivery Fiber through the top of the SoloVPE instrument and reattach it to the SoloVPE Translation Stage 

connection by aligning the notch into the keyway and rotating the FC connector end clockwise (see the image below). 
 

 
Figure 38. Reconnect Delivery Fiber to Translation Stage. 

Run a Quick Check Test 

1. Click the Quick Check button on the SoloVPE Toolbar to start Quick Check.  
2. Click the Quick Check button on the Quick Check Diagnostic Check window that appears to begin testing. 
3. Quick Check will present a prompt instructing the user on how to prepare the Fibrette Optical Component and SoloVPE 

System for the test (see Figure 39). It is critical that the test is run under the following conditions: 
• A clean, new Fibrette Optical Component should be pushed fully upward until it stops. Do not pull down.  
• The SoloVPE Detector Window should not have a sample vessel or sample vessel holder in place.  
• The SoloVPE cover should be in the down position. 
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Figure 39. Prepare for Quick Check window prompt and requirements. 

4. Once the Fibrette Optical Component and SoloVPE System are prepared as described, click the OK button to continue the 
test. 

5. Quick Check will automatically move the Fibrette Optical Component to make transmission measurements.  
6. When the test is completed, a prompt will appear asking if there are comments to be added to the Quick Check Test. 

Clicking No clears the message, clicking Yes displays an input box into which comments can be entered.  
7. Upon completion, the Quick Check window will display the disposition of the SoloVPE System, which can be Fail or Pass, as 

depicted in Figures 40 and 41. 
• A passing result means the system observed a transmission of 70.00% or greater. This number is derived from the 

baseline transmission using the Coupler Check.   
• A failed result means transmission is too low for most measurements, either through particulates, debris, or 

blockage in or in front of the optical path. Perform the Daily and Weekly Maintenance Best Practices and retry the 
Quick Check once completed. (For more details, refer to Table 10 of Troubleshooting Low Transmission in Section 
5.3.18.) 

• The Pass/Fail criteria can be revised using the [Advanced] button and adjusting the Disposition Value (Pass/Fail). 
Repligen recommends keeping this value at 70.00%. 

 

 

    
 

8. Click View Log to see more details on the Quick Check results. 
• Filter Type allows the user to sort the results between All Types, Coupler Check, and Quick Check. 
• Users can define specific dates and times to find results. Click Refresh Results after selecting the range of dates and 

times to see the search result. 
9. Click Done to close the Quick Check window.  
 

5.3.16 Additional Quick Check Features 

Quick Check provides ways to review logs and print results of the Quick Check Tests to simplify integration of this diagnostic tool into 
organizational protocols. These features include Report Result, View Log, and Advanced. 

Figure 40. Failed Quick Check 
diagnostic. 

Figure 41. Passed Quick Check 
diagnostic. 
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Report Result 

Allows the user to report the current Quick Check score to the report.  
 
View Log 

Clicking the View Log button opens the Quick Check Summary Log File Viewer, as depicted in Figure 42, which shows the history of 
Quick Check Tests that have been performed on the system. The View Log button is active any time there are Quick Check and 
Coupler Check records in the Quick Check Summary Log file. 
  

 
Figure 42. Quick Check Summary Log File window. 

1. Filters allow users to search specific times and dates of Quick Checks. Select the Type dropdown menu to change the 
Summary Log between All Types, Coupler Check Only, and Fibrette Check Only. 

2. Click the […] button to select the desired range of dates and times. 
3. Click Refresh Log to view the search results.   
4. Click Report to print a single selected Quick Check Summary into the Report window of the SoloVPE software.  

 
Plot History 

The Plot History button provides the user with the means to create a graph of the Quick Check Test results in the Graphics window. 
Clicking the Plot History button will first prompt the user to continue if they wish to append the Existing Report.  
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Figure 43. “Send Log File to Report Window?” prompt. 

Once OK is selected, the software will open a plot configuration window on which the user can specify which Quick Check data is to 
be plotted. The plot default is the disposition data of Percent Transmission at 500 nm at the Zero Pathlength position; however, the 
user can specify any of the four wavelength/pathlength combinations to plot: 500 nm at Home Position, 500 nm at Zero Position, 
250 nm at Home Position, or 250 nm at Zero Position (see Figure 44).  
 

 
Figure 44. Specify Plot Data window. 

After selecting from the four available %T options, clicking the Plot button will generate the Graph and the corresponding report. 
Plot History allows users to plot the Quick Check Data on to a graph. Select the desired %T, wavelength, and position. The graph is 
plotted as Diagnostic Percent Transmission vs. Test Sequence ID. See Figure 45 for an example of a plotted graph. 
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Figure 45. Plot History graph and associated report. 

• Export CSV allows users to save the Quick Check Summary Log File. The button will prompt users to enter a File Name under 
Save As. 

• Report Log prints the Quick Check Summary Log into the Report window of the SoloVPE software. The button will prompt 
users to confirm that they want to append the data to the current report window. 

 
5.3.17 Advanced Settings 

Advanced Settings will give users the ability to define the Coupler Check Change Threshold, Disposition Value, Method Wavelength, 
as well as the pass and fail result message. Scheduled reminders allow users to schedule Coupler Check reminders. 
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Figure 46. Quick Check settings window. 

View Log Button 

The View Log button allows users to see results from Quick Check tests. Refer to Figure 42 for a depiction of the Quick Check 
Summary Log File window. 
 
5.3.18 Troubleshooting Low Transmission 

The Quick Check Diagnostic Tool is very useful for confirming that the SoloVPE System is achieving acceptable transmission. Utilizing 
troubleshooting approaches for responding to the information provided by Quick Check is critical for maximizing the SoloVPE System 
Quick Slope feature. This section provides guidance on what steps, if necessary, to take in response to Quick Check Results. 
 
The following instructions explain a simple troubleshooting approach that can be used to identify and resolve the most common 
causes of low system transmission. 
 

1. Fibrette: Use a new Fibrette Optical Component and repeat Quick Check measurement. 
2. Fibrette Couplers: 

• TBA Fibrette Coupler: Loosen the Fibrette Coupler and replace with a new one.  Make sure the Fibrette Coupler is 
fully engaged into the translation stage. 

• Quick Set Fibrette Coupler Insert: Remove the Quick Set Fibrette Coupler and, if possible, use a compressed air can 
to blow compressed air through it. 

3. Delivery Fiber: Follow the procedure for removing and cleaning the Delivery Fiber in Section 4.5. If available, use a 
compressed air can to gently blow any fibers away.  

4. Detector Window: Use methanol or isopropyl alcohol and a cotton swab to clean the window that covers the Detector in 
the sample stage. If available, use a compressed air can to gently blow any fibers away. 

5. Repeat the Quick Check steps above after cleaning the various components of the optical path. 
6. Clicking Done will close the Quick Check window.  
7. If there are any issues, please call the VPT Support direct line at (908) 707-1201 for assistance. 
 

Note: Quick Check Transmission issues can most frequently be traced to the cleanliness of the Fibrette Optical Component and/or the 
Delivery Fiber and are usually resolved by a simple cleaning. 

  
Table 10. System result Pass/Fail causes and actions. 
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Quick Check Feedback Probable Cause(s) Recommended Actions 

System Health = Pass Transmission is optimal for 
sample measurements. 

Continue using as desired. 

System Health = Fail Transmission is too low for most 
measurements, either through 
particulates, debris, or blockage 
in or in front of the optical path. 

1. Clean or replace the Fibrette Optical Component. 
2. Clean the Delivery Fiber FC Connector end (SoloVPE end). 
3. Clean the Detector Window. 
4. Consider swapping out the Delivery Fiber if a spare is 

available. 
5. Repeat the test after trying these cleaning steps. 
6. Contact the Customer Success Group at (908) 707-1201 

for troubleshooting. 

 
5.4 Manual Control of the SoloVPE System 

The SoloVPE software comes with a utility to directly control the SoloVPE hardware. This functionality is very useful for verifying the 
transmission of the SoloVPE System, performing routine maintenance, and even checking and performing very simple data 
collections. Figure 47 shows the Manual Controls window.  
 

 
Figure 47. SoloVPE Manual Controls window. 

5.4.1 SoloVPE Manual Controls: Pathlength Controls 

The Manual Controls window allows direct control of the SoloVPE hardware. The SoloVPE Controls are summarized in Table 11. 
 
Table 11. SoloVPE Manual Controls: Pathlength control summary. 

Control Command Description 
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Sample vessel Specifies the sample vessel being used while in operation. Proper selection is critical to ensure 
accurate pathlengths  

Goto Home Drives the SoloVPE to the Home loading position. 

Goto Zero Drives the SoloVPE to the Zero Pathlength position. 

Goto Pathlength Prompts the user for a specific pathlength value and then drives the SoloVPE to that pathlength. 
Zeroing the Fibrette Optical Component is necessary in ensuring greater accuracy. 

Increase PL Increases the SoloVPE’s current pathlength by the pathlength change value specified. 

Decrease PL Decreases the SoloVPE’s current pathlength by the pathlength change value specified. 

Pathlength Change field The numerical field that specifies the magnitude of the pathlength shift when the user clicks the 
Increase PL or Decrease PL buttons. 
Located between the Increase PL and Decrease PL buttons. 
Smallest allowable value is 0.005 mm. Largest allowable value is 15.000 mm. 

Limits On This checkbox enables or temporarily disables the SoloVPE positional safety checks that prevent 
unintended component interactions during normal usage.  
This capability allows proper setting of the Zero Pathlength Position. 
This feature is password-protected and disabling limit-checking should only be done by trained 
Support personnel.  

Set Zero Wizard This button closes the Manual Controls window and begins running an application that guides the 
user through setting the Zero Pathlength position for the SoloVPE. 
This feature should only be used by a VPT Support Specialist. 
This feature is password-protected.  

Set Zero Position This button is used to update the location of the Zero Pathlength position and should only be used 
by a VPT Support Specialist.  
This feature is password-protected. 

Optimize Coupler This button will start the Fiber Optic Coupler Optimization utility used to maximize the transmission 
of the system.  
The system will collect and display real-time transmission data to give the user direct feedback on 
the throughput of the system while adjusting the Fiber Optic Coupler or other optical components. 

 
5.4.2 SoloVPE Manual Controls: Cary Controls 

The Manual Controls: Cary Controls provides the ability to take a quick reading of absorbance or transmission. This capability is 
useful for performing routine system checks and maintenance, as well as performing alignment procedures and setting the Zero 
Pathlength position. The Cary Controls are summarized in Table 12. 
 
Table 12. SoloVPE Manual Controls: Cary Controls summary. 

Control Command Description 

Y Mode Toggles the Cary 60 data mode between Absorbance (Abs) and Transmission Percentage (%T). 
Applies to the Quick Read and the Quick Scan features. 

Quick Read Clicking this button will execute a single point read at the specified wavelength in the Quick Read 
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field and print the result to the Report window. 

Quick Read field Preceded on screen by the “@,” this numerical value is the wavelength at which the Quick Read 
feature will collect and report the Absorbance or Percent Transmission value. 

Quick Scan Clicking this button will execute a spectra collection and display the resultant curve in the Graphics 
window, according to the Start nm/Stop nm fields. 

Start nm/Stop nm fields These numerical values are the specified beginning and ending wavelengths for the Quick Scan 
feature. 

 
5.5 Scatter Correction Settings 

The SoloVPE System was designed to allow the use of scatter correction algorithms.  Light scattering can decrease the accuracy of 
the determined concentration and, as a result, any scattering must be corrected out.  
 

• Scatter Correction Enabled: Checking this option enables scatter corrections. 
• Scatter Correction Algorithm: The dropdown list box displays available scatter corrections routines. The user makes a 

scatter correction option from this list. There is a total of six options to choose from for scatter correction (see Figure 48), 
which will be outlined in the following section. 

 

 
Figure 48. Quick Tool: Scatter Correction options. 

5.5.1 Quick Slope Corrections: Baseline, Single λ Scatter, Dual λ Scatter, V3 Scatter Methods 

Quick Slope Baseline Correction 

An option offered within the Quick Slope application called Baseline Correction allows users to run a baseline correction with their 
sample. While running this function will not cause any issues with data obtained, it may be an unnecessary action.  
 
Generally, the SoloVPE System does not require baseline corrections because the user is no longer looking at absolute absorbance. 
The SoloVPE System instead uses slope to determine the concentration. If the buffer being used does not have a slope (or little to 
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none), then it should not contribute to the actual slope of the sample. Comparing the corrected slope with an uncorrected slope will 
most likely show the same results. This is very common in highly concentrated samples. 
 
With certain buffer types, such as ones containing methanol, a baseline correction may be needed—most specifically when there is a 
non-zero slope that contributes to the sample or has pathlength dependency. Another reason a user might need a baseline 
correction is if the sample is very dilute, less than 1 mg/ml. When measuring a sample that is very dilute, it is important to 
remember that even a small non-zero buffer slope could be significant when measuring a sample that should already have a small 
slope. 
 
To find out if baseline correction is needed, a user may run the buffer sample as if they were running a Quick Slope on the actual 
sample. The slope value obtained from running the Quick Slope will not be exactly zero. This is due to noise and optical loss from the 
Cary instrument to the SoloVPE instrument. If the slope value is less than 0.01, baseline correction is typically not required to run the 
sample. This is due to the lack of slope presence within the sample. The slope value will provide the information required to 
understand if the correction is required or not. See Figure 49 below.  
 

 
 

Figure 49. Buffer with low slope value. 

If the Slope value is greater than 0.01, it is possible that the pathlength dependence of the buffer is real and baseline correction will 
be required. Refer to Figure 50. 
 

 
 

Figure 50. Buffer with high slope value. 

 

A user may also run the sample with Baseline Correction enabled. After the baseline has been run and Quick Slope has 
determined that a baseline was not needed, an alert will appear (see left). The SoloVPE software determines this when 
the slope of the baseline is so small that it may not be required.  
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When performing either test to find out if baseline correction is needed, it is important to completely fill the selected sample vessel. 
Quick Slope works by using predefined pathlengths to create a baseline section that will cover the entire height of the sample vessel. 
Quick Slope interpolates the correction value from the baseline section data, instead of visiting every single pathlength, a time-
consuming process. Doing so allows the software to adapt to the threshold pathlength and step size that the Quick Slope application 
finds during the sample data acquisition.  
 
Scatter Correction 

UV spectroscopy is commonly used for determining the concentration of a protein solution. However, in protein solutions where 
particles appear that are comparable to the size of the wavelength at which the absorbance is being determined, light scattering 
may occur. Light scattering can decrease the accuracy of the determined concentration of the protein and as a result any scattering 
must be corrected out. There are multiple methods of determining and correcting light scatter, some of which are presented below.  
 
Single Wavelength (SW) Scatter Correction 

Single Wavelength (SW) scatter correction works by taking data points at two different wavelengths at the same pathlengths. It then 
subtracts the absorbance at the SW from the absorbance at the method wavelength to create a corrected absorbance at the 
specified method wavelength. This will isolate the absorbance contribution of the key species being measured at the method 
wavelength. 

 
 

Figure 51. Data collected before scatter correction with SW scatter. 
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Figure 52. The corrected absorbance at the method wavelength. 

Dual Wavelength (DW) Scatter Correction 

Dual Wavelength (DW) scatter correction works differently than SW Scatter Correction. Instead of subtracting one slope line from 
the other and shifting the results down, DW will use the two scatter wavelengths to project an absorbance value to be subtracted 
from the expected wavelength. The DW feature is similar to a three-point drop correct method, which quantifies a sloping scatter 
contribution line and makes a correction based off of the absorbance values obtained. Each individual pathlength will be calculated 
separately, point for point, as the section data is collected.  
 
Figure 53 shows the raw data taken before any scatter correction is calculated. The projected points come from the 320 nm and 350 
nm data points, all taken at the same pathlength. 
 

 
 

Figure 53. Data collected before scatter correction occurs. 

The scatter contribution is determined by defining the line that passes through those two points using the equations below. 
 

 
 

Where x1 and y1 are points taken from the 320 nm and 350 nm wavelengths. 
 

 
 

After solving for the slope of the projected line, the value of m is plugged in to solve for the y-intercept (b). 
 

 
 

Once b has been solved for, we are able to calculate the corrected y-abs value by subtracting the absorbance of the scatter value 
from the absorbance at the method wavelength. 
 

 
(At the method wavelength.) 
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After performing the above calculation for each pathlength, the slope of the section data will remove the contribution of scatter. 
Figure 54 shows the corrected absorbance at the method wavelength after subtraction. 
 

 
 

Figure 54. Corrected absorbance at the method wavelength. 

SoloVPE V3+ Using Logarithmic Scatter Correction: Scan, Dual Ln, and Multi Ln WL Scatter Corrections 

Scan, Dual Ln, and Multi Ln WL Scatter Corrections are all considered Rayleigh scatter correction methods. Each method takes a scan 
at specified pathlengths over a specified wavelength range to create a scatter absorbance value to correct the collected raw data. 
Scan WL takes an aggressive scan over the specified wavelength range. Dual Ln only takes the two end data points of the specified 
wavelength range, and Multi Ln collects data at every 5 nm. 
 
In each case, the algorithm to project the scatter and then correct the raw data is the same, aside from the amount of data used in 
the algorithm. The calculations begin by taking the log of raw WL data and the log of raw absorbance data and then creating a log vs. 
log plot. The slope is calculated by plotting a trend line over the scatter wavelength range in Figure 55. The scatter contribution is 
calculated by using the slope equation y = mx + b.  
 

 
 

Figure 55. Log vs. log plot. 

The application of the slope equation demonstrated below is for Dual Ln, but can be applied to Multi Ln and Scan WL by inputting 
more data points. 
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Example: 
If the wavelengths chosen for scatter are 350 nm and 320 nm and correcting at 280 nm. 
 

 
 

 
The scatter value is converted to absorbance using the equation below: 
 

 
 
The scatter value is then subtracted from the raw data to plot the corrected absorbance.  
 

 

 
 

Figure 56. Corrected absorbance scan. 

Dual Discrete Scatter Correction 

The dual discrete scatter correction equation is 
 

 
 
For further information regarding these Quick Slope Correction tools, see SoloVPE Software Quick Slope Corrections: Baseline, Single 
λ Scatter, Dual λ Scatter, V3 Scatter Methods KBA14003. 
 
Volume/Pathlength Estimator 
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Vessel selection is an important step in configuring a SoloVPE method. Selecting the correct vessel enables the system to validate 
the configuration of the user’s pathlength choices. Each vessel has a profile including a maximum possible pathlength.  
 
Once the vessel choice is made, the system confirms that the pathlength configuration is possible for the given vessel. The system 
also provides an estimated volume requirement based upon the pathlengths to be collected and the vessel being used. These 
estimates provide a useful reference when preparing the sample. 
 
Sectioning: Creating a Pathlength Cross Section Curve 

Once the user has collected data at various pathlengths, the SoloVPE software allows the user to create pathlength cross section 
curves or PLX curves. To do this, the user must open the Section window by clicking the Section button on the sidebar. The Section 
window is displayed in Figure 57. There are four simple steps to follow, detailed in the following procedure.  
 

 
Figure 57. Pathlength Cross Section window. 

Create Cross Section (PLX) Curves from Spectra 

This procedure describes how to quickly and easily create section (absorbance vs. pathlength) curves from variable pathlength data 
sets. 
 

1. Click the Section button in the sidebar. When the window opens, it examines the data to determine what data sets are 
available for sectioning. A data set is defined as a sequence of absorbance points or spectra collected with a common 
configuration but at different pathlengths. Baseline raw data and corrected data are eligible for sectioning. The program 
will also determine if any Section graphs (absorbance vs. pathlength graphs) are available for displaying newly created PLX 
Curves. These details are used to populate the dropdown list boxes. If no eligible data sets are found, the window will not 
display.  

2. Select the data set to section from the Select Dataset dropdown list box. 
3. Select the target to display the new cross section curve. The user can then select an existing absorbance vs. pathlength 

curve from the dropdown list box or select <New Graph> to create a separate one. Selecting <New Graph> will prompt the 
user to enter a name for the created graph. 

4. Enter the wavelength to be created for the cross-section curve.  
5. Click the Create Wavelength Cross Section button to generate the new PLX curve.  
6. The window can now be closed and analyzation of the new PLX curve can occur. 
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5.6 Analysis: Analyzing Cross-Sectional Curves 

The Analyze screen provides powerful tools for working with Section data. To use the Analyze function, the user must first select a 
valid cross section (PLX) curve to analyze. This is done by selecting the curve of interest with the mouse. 
 
With the desired trace selected, click the Analyze button on the sidebar to display the SoloVPE: Data Analysis Toolbox window 
(Figure 59). If the selected trace is not a valid Section curve, a notification message will be displayed and the Analyze window will not 
open.  
 
Software Tip: Selected Trace Appears in Red  

The selected graph will always appear as shown below, and its name will be at the bottom of the Graphics pane. The Active Trace is 
always on the Active Graph and will appear in red. The name of the Active Trace will appear next to the name of the Active Graph in 
the Graphics Pane label. 
 

 
Figure 58. Active Trace in the Graphics window. 

Opening the Data Analysis Toolbox window from the sidebar will display detailed information about the selected Section Curve. This 
will include the name of the trace, the data set from which it is derived, the wavelength from which it was created, and the sample 
name if applicable. It will also display information about the Section Curve data itself including a number of data points, min and 
max pathlengths and regression statistics for the entire data set.  
 

 
Figure 59. SoloVPE Data Analysis Toolbox window. 

 

Name of  
Active Graph 

Name of  
Active Trace 

Active Trace 
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As shown in the figure above, the window is divided into multiple sections: Trace information at the top of the window, Regression 
Configuration in the middle, and the Regression Results at the lower right. The Regression Configuration section provides the 
primary tools used in analyzing section curves. 
 
Regression Configuration: Analysis Tools 

The Regression Configuration section provides tools that allow users to optimize the regression of their data and better understand 
the results by viewing which data points are included in the regression analysis.  
 
The primary purpose of the Data Analysis Toolbox is to perform regression analysis on the data. Since the data is based on Beer’s 
law, the variable pathlength data should be linear.  
 
The Data Analysis Toolbox window provides multiple ways of optimizing the regression statistics to determine the linear range of the 
section data. The following procedure describes the various ways a user can analyze the section data sets. 
  
Analyze Section Data with Regression Tools 

This procedure describes how to optimize the regression statistics of the selected section data set in the Data Analysis Toolbox 
window. 
 

1. Select the section curve of interest in the Graphics pane. (Remember: Section plots are absorbance vs. pathlength graphs). 
2. Click the Analyze button on the sidebar to open the Data Analysis Toolbox.  

• If the selected curve is not a valid section data set, the system will display a notification and the Analyze window 
will not open. When first opened, the Analyze window will display the information available about the data set and 
the regression results for the entire data set.  

 
Data in Context: One of the most powerful attributes of the SoloVPE System is its ability to display the data in context. Specifically, it 
can provide visual confirmation that the collected data is behaving linearly as predicted by Beer’s law. The Analyze window gives 
users the tools to work with the data fine-tuning the regressions data points, allowing the user to remove nonlinear points from the 
regressed results. 
 
Users can manually adjust the data included for regression in two different ways. Users can use the PL Boundaries feature or the 
Add/Remove Data Point buttons to configure which data points to include in the regression analysis. 
 
Clicking the PL Boundaries button opens the Specify Start and End Pathlengths window, which lets users choose the pathlength 
boundaries of the regression data set. Clicking the OK button updates the Regression statistics in the Analyze window. 
 

 
Figure 60. Specify Start and End Pathlengths window. 

The Add and Remove buttons let the user manually add and remove data points from the regressions analysis. Notice that four 
appear on both the Min-PL and the Max-PL line. The “+” and “-” buttons will add or remove a data point from the data set from 
either the Minimum Pathlength or Maximum Pathlength.  
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The “|<+” and “->|” symbols are called Jump Add and Jump Remove buttons. Clicking those will jump to the extreme data point 
options. As the user clicks these buttons, the regression statistics will update with each click, the graph will display blue lines that 
show the current pathlength boundaries and the buttons will toggle on and off based upon what options exist. 
 
Another option for selecting the linear region of the Section data set is the Optimization feature. When the Optimize R-Sqr button is 
clicked, the user will be prompted for the number of data points to use for the optimization routine. The system will then calculate 
every possible regression result using that number of adjacent data points and show the results to the user. The system will highlight 
the line with the highest R2 value (see Figure 61). 
 

 
Figure 61. Coefficient of Determination Optimization window. 

Make Slope Spectroscopy Calculations from Within the Analyze Window 

This procedure describes how to calculate concentration or extinction coefficient from section data sets by using the Slope 
Spectroscopy equation, regression data, and known properties of the sample. 
 
Calculations can be made based upon the Slope Spectroscopy equation which defines the relationship between slope, 
concentration, and extinction coefficient. The Analyze window gives users access to the measured slope value. When a value for 
either the concentration or the extinction coefficient is known, the other value can be calculated. 
 

1. If the user selects Concentration, the Extinction Coefficient controls will be visible; alternatively, selecting Extinction 
Coefficient will make the Concentration fields visible.  

2. The user can enter an extinction coefficient selected from the system’s Extinction Coefficient Library if it has previously 
been entered. 

• If “Unknown,” the concentration will not be calculated.  
3. The Analyze window has options for specifying the Concentration. If the Concentration of the sample was previously 

entered in the Sample Information screen, selecting Sample Info from the Concentration Source list box will call that value 
into the screen. 

4. Select User from the list. The user can manually enter the known concentration to be used in the calculation. 
5. Specifying a value updates the calculated result, as will clicking the Calculate button.  

 
Other Analyze Window Features 

The Analyze window also allows users to perform some other useful functions such as overlaying the regression line over the Section 
data set points, projecting the regression line out to a theoretical user-specified pathlength, or printing the results of a given analysis 
and saving the analysis results to a comma delimited (*.CSV) file.  
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SoloVPE Toolbar 

The Slope Analysis Tool can be thought of as a miniature Analyze screen. It has many of the same regression analysis capabilities in a 
smaller window with the added benefit of being able to switch between available section curves (see Figure 62). 
 

 
Figure 62. Slope Analysis Tool window. 

The Slope Analysis Tool gives access to many of the same features in the Analyze window. These capabilities include the ability to 
add and remove data points from the regression set and the ability to use the R2 optimization function. Additionally, this also 
includes the ability to calculate either the concentration based on the regression results and a user-specified extinction coefficient, 
or the extinction coefficient based on the regression results and a user-provided known concentration. 
 
The Slope Analysis Tool makes it easier to see the graphics window and the report window while working with the data. The Section 
Selector allows users to switch between Section data sets without closing and opening the window.  
 
The Slope Analysis Tool window provides visual tips for the validity of the regression results when the absorbance levels themselves 
appear to be either too high or too low. Such indicators help users maintain the highest levels of accuracy when using the SoloVPE 
System. 
  
5.7 Reporting: The Report Configuration Window 

The Report Configuration screen allows users to filter the data that will be reported on, as well as what information to display about 
that data. It generates the report to the Report window pane which can then subsequently be saved to as a file or sent to a printer 
using the File > Print option from the menu, if a hard copy is desired. The Report Configuration screen is shown in Figure 63. 
 

 
Figure 63. Report Configurator window. 

The Report Configuration window is divided into two major sections: the Trace Filter panel and the Options panel.  
 
The Trace Filter panel allows the user to specify what trace data the user reports on. The user can report on all the Traces in 
memory, the currently selected or Focused Trace, or traces associated with specific curves or a data set. Once the user has specified 
which traces to report on, the user can adjust what appears on the report. 
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The Options panel include the company logo, the data stored in the User Data Form, an insert of the Graphics region, the specific xy 
data for the traces, and the Sample Info. The xy data table can also display the data in the summary. 
 
Click the Run Report button to generate the report. Once generated, the report can be printed using the File > Print option from the 
menu bar. Once the user has made the selections and is satisfied with their report, the user can choose to clear any existing 
information from the report screen by clicking the Clear Report button. 
 
Create a Custom Report Using the Report Configuration Window 

This procedure describes how to create a report using the Report Configuration window by filtering data and specifying what types 
of information to use for the report. 
 

1. Open the Report Configuration window by clicking the Report button on the SoloVPE Sidebar.  
Note: Data in the form of either spectral or section data must be present. 

 
2. Filter Data for desired report content using the Trace Filter controls. The options for controlling the data to be included in 

the report are as follows:  
• All Curves: This option will generate the report on all the curves of all types currently in the system's memory. This 

is the broadest option and in effect does not filter at all. 
• Focused Trace: The is the most selective option and runs the report on the currently selected trace at the time the 

Report window was opened. The name of the currently selected trace is displayed below the selector. 
• By Curve Type: This option allows the report to be filtered based upon a specific type of curve including baseline 

curves, section, raw (data) curves, data (corrected data) curves, regression curves, and other (filters for 
unrecognized curve types). 

• By Dataset: This option filters by families of curves such as related baseline curves, curves from the same sample, 
etc.  

3. Configure the Report Options using the controls in the Options Panel. The options available are described as follows:  
• Company Logo: Enabling this option will display the currently installed company logo in the Cary WinUV software 

in the upper left-hand corner of the printed report. It is important to note that the icon will not be visible in the 
Report window pane but only in the printed report as a header.  

• User Data Form: Enabling this option configures the report to print the information currently stored in the User 
Data Form to the report when the Run Report button is clicked. The User Data Form typically contains information 
related to how and when the curves were acquired and additional details depending on the type of curve (e.g., 
Data, Section, Regression etc.). 

• Print Graph: Enabling this option will configure the system to print the Graphics window pane at the top of the 
printed report when the File > Print option is used. It is important to note that this option does not display the 
graphics region in the Report window, but has the Graphics window pane print on the hard copy of the report 
when sent to the printer. 

• %Ht x %Wd Settings: This setting controls how the printed graphics region appears on the hard copy of the report. 
The default settings of 50 and 100 respectively dedicate half of the first-page height and its full width to the display 
of the Graphics window pane. The user can adjust these percentages to control the amount of the printed page 
used to display the Graphics window.  

• Print X-Y Pair Table: Enabling this option will configure the report to print a table of the X and Y data point values 
for each curve to be reported on when the Run Report button is clicked. The data interval itself can be adjusted by 
the user. 

• Data Interval: This setting is used to adjust the X-Y data table display. If this option is left unchecked (not enabled) 
the data in the X-Y data table will be the raw data acquired by the system. If this option is enabled the user can 
enter a specific data interval in the field provided to constrain the table step sizes. For example, when printing an 
X-Y data table for a spectrum collected at every nanometer, the user may elect to display every third nanometer by 
specifying 3 to compact the data results. If the user elects to use smaller data intervals such as 0.25 nm or 0.5 nm, 
the system will interpolate the values for use in the data table. 

• Sample Info: Enabling this option will configure the report to print the information that was entered into the 
Sample Information screen when the Run Report button is clicked. When curves included in the report were 
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acquired using Quick Slope, Quick Survey, or other modules that do not rely on the Sample Information screen, this 
information will be left blank.  

• Insert Graph in Report: Enabling this option configures the system to display the current graph(s) in the Report 
window. This option differs from the Print Graph option in that this option inserts graphs into the Report window 
as an image which is visible on the screen, and the Print Graph option only applies to printed hard copies of the 
report. If both options are enabled, physically printed reports will display each graph twice. Filters do not apply to 
the displayed graphs, which are presented as they appear in the Graphics window. To synchronize the graphics 
display with the filters, the user must first use the Graphics window controls to have the graphs display the desired 
information. 

4. Prior to running the report, any additional comments about the report can be typed into the Comments field provided. This 
information will appear in the header information at the top of the report.  

5. When running the report, the user must first decide to clear any existing information from the Report window. To clear the 
Report window entirely, click the Clear Report button. The user will be asked to confirm deletion of the existing report 
information. 

 
Note: This will permanently delete any information that was not previously saved. If the user wants the new report to be appended to 

the current Report window, do not click the Clear Report button.  
 

6. Run the report by clicking the Run Report button. When selected, the user will see the report content generate in the 
Report window. Depending on the amount of data to be reported, the report may run for up to a minute. The system will 
display a notification when the report run is complete.  

7. When the report is completed, click the Done button to close the Report Configuration window and review the contents of 
the report.  

8. To send a copy of the report to a printer use the File > Print option from the menu. 
  
5.8 SoloVPE Administration 

SoloVPE Administration will allow the Administrator of a system to have all the security/backup settings of a system in one central 
location.  
 
The User Account Control (UAC) is a feature in Windows that can help the user stay in control of the computer by informing the user 
when a program makes a change that requires administrator-level permission. The SoloVPE Administration application is tied with 
the UAC setting of Windows. Any changes made in the SoloVPE Administration application require an administrator with proper 
privileges on the computer. For customers that have purchased the optional security package for the SoloVPE System, there are 
additional controls and means of system administration that are explained in SecureVPE User Manual (Version 3) for that package 
 
When the Admin button is clicked on the SoloVPE sidebar, a prompt is displayed for the elevation of the User (see Figure 64). If a 
non-administrative user logs in, they will be prompted for the proper administrative Windows credentials to log in. The correct 
password must be entered to open the SoloVPE Administration window. 
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Figure 64. User Account Control (UAC) window. 

During the software installation, it is recommended that IT personnel be present to verify the proper UAC settings have been 
selected per the companies’ policy. Also, during Preventative Maintenance/service visits, the IT personnel at that location must 
provide the VPT Support Specialist with proper administrator privileges.  
 
5.8.1 SoloVPE Administration Overview 

The SoloVPE Administration window contains device information, settings, support files, and software licensing. It is through this 
window that configuration details specific to the organization, device, and details of the system can be configured. It is important to 
avoid making changes in any of the SoloVPE Administration modules without specific guidance from a certified VPT Support 
Specialist. 
 
Should a user require guidance on the proper use of SoloVPE Administration features, please contact the Customer Success Group 
through established local or international channels. 
 

 
Figure 65. The SoloVPE Administration window. 

The descriptions included below are not meant to provide specific instructions for the utilization of these features; they are intended 
to provide familiarity with the capabilities and awareness of where these functions can be found should it become necessary to 
make changes under the direction of a certified VPT Support Specialist. An overview of the features and functionality of the SoloVPE 
Administration window are shown in Table 13 below.  
 
Table 13. SoloVPE Administration features and functions. 

Control Command Description 

Device Clicking the Device button displays a dialog window in which key system parameters, such as the Model, 
Serial Number, Zero Pathlength Position, and Resolution information, can be reviewed and updated. 

Solo Clicking the Solo button displays a dialog window that gives the administrator full control over settings 
for the SoloVPE software. Time and Date display options can be found here, along with decimal place 
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configurations, save path locations, and many more parameters. 

Vessel Clicking the Vessel button displays the parameters of the small, micro, large, and plastic vessel types in 
the SoloVPE software. 

UI Options Clicking the UI Options button displays a dialog window with controls to Grant or Revoke visibility to the 
SoloVPE sidebar buttons. This is especially useful to users that do not have the SecureVPE software. 
Note: This option will not appear when SecureVPE is installed.  

Data Stores The Data Stores button allows the admin to view the default saving location for the Application Data, 
Extinction Coefficient Data, Optimization Algorithms, Session Logging, and Quick Method Data. 

VPE System Service The VPE System Service button provides optional security features for locking down the user interface 
and locally saved files.   

Licensing Click the License button to view or modify the system’s software license(s). Licenses should only be 
added or modified by a trained VPT Support Specialist. 

Support Gathers information to be used by the Repligen Customer Success Group (CSG) to help diagnose and 
resolve SoloVPE software issues. Simply click the Generate button and send the file to a VPT Support 
Specialist. 

 
5.8.2 SoloVPE Administration: Solo Parameter List 

The Solo Parameter list in the SoloVPE Administration tool is a list of settings that allow Administrators to fine-tune and configure 
the SoloVPE environment and software behavior. Not all settings will be applicable to every implementation since not all features 
are used by all users. The following information (Figure 71) is a list of the Solo Parameters and a brief description of their meaning 
and use.  
  
Table 14. SoloVPE Administration features and functions. 

Solo Parameter Name Default Value Description 

VerboseLoggingEnabled  False Low-level system parameter intended to be used by trained Support 
personnel for system maintenance and troubleshooting. Enables or 
disables more detailed event logging in the WinUV environment. 

ExportLogWithCSV False Toggles the export of the Data Audit Log on and off when using the Save 
As *.CSV feature of the WinUV Save As dialog. 

DoubleZeroEnabled True Low-level system parameter intended to be used by trained Support 
personnel for system maintenance and troubleshooting. Should remain 
in the True state but is capable of reverting to a simpler Zero Pathlength 
action. 

DefaultVessel 3 Specifies the default vessel type selected when the software runs.  

R2 DisplayDigits 6 Broadly controls the number places displayed when the system display 
outputs R2 data to the screen and reports. 

SlopeDisplaySettings 5 Broadly controls the number places displayed when the system display 
outputs slope data to the screen and reports. 

ECDisplayDigits 4 Broadly controls the number places displayed when the system display 
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outputs extinction coefficient data to the screen and reports. 

ConcDisplayDigits 5 Broadly controls the number places displayed when the system display 
outputs concentration data to the screen and reports. 

AbsDisplayDigits 5 Broadly controls the number places displayed when the system display 
outputs absorbance data to the screen and reports. 

TransDisplayDigits 5 Broadly controls the number places displayed when the system display 
outputs transmission data to the screen and reports. 

StatsDisplayDigits 5 Broadly controls the number places displayed when the system display 
outputs statistical data to the screen and reports. 

WavelengthDisplayDigits 2 Broadly controls the number places displayed when the system display 
outputs wavelength data to the screen and reports. 

PathlengthDisplayDigits 3 Broadly controls the number places displayed when the system display 
outputs pathlength data to the screen and reports. 

SecondsDisplayDigits 2 Broadly controls the number places displayed when the system display 
outputs seconds data to the screen and reports. 

DefaultDateFormat yyyy-mm-dd Broadly controls the date formatting when the system displays date 
information on the screen and in reports. 

DefaultTimeFormat hh:nn:ss Broadly controls the time formatting when the system displays time 
information on the screen and in reports. 

DefaultDateTimeFormat yyyy-mm-dd 
hh:nn:ss  
AM/PM 

Broadly controls the date and time formatting when the system displays 
time information on the screen and in report. 

DecimalDisplayDigits 5 Broadly controls the decimal digits displayed on the screen and in 
reports. 

DefaultMVPSeedFile SoloVPE.MVP Low-level system parameter (should not be changed) specifying the 
generic method file that is used by the SoloVPE software when the 
software opens. 

DefaultSavePath C:\Users\Public\Documents
\cTechnologies\SoloVPE\ 

The global default save path that is used for non-WinUV save dialog 
windows. This parameter is a global default that can be overridden by 
Personalization when the SecureVPE software is enabled. 

EnabledSessionLogging False Low-level system parameter intended to be used by trained Support 
personnel for system maintenance and troubleshooting. Enables or 
disables a detailed logging feature within the SoloVPE software. When 
enabled, performance is dramatically reduced due to the burden of this 
feature. 

SessionLogType Internal Low-level system parameter intended to be used by trained Support 
personnel for system maintenance and troubleshooting. Parameters 
specify the output format of the session logs. 

ReportGraph False Toggles whether the graphics region in the SoloVPE software will print 
as its own region during hard copy output. When enabled, wrapping and 
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formatting can be negatively impacted, which is why the default state is 
false. 

ReportXScale 100 Low-level system parameter that controls the output width percentage 
dedicated to the printing of the WinUV graphics region.  

ReportYScale 100 Low-level system parameter that controls the output height percentage 
dedicated to the printing of the WinUV. 

Primary HGraphX 750 Low-level system parameter that controls how the Horizontal Auto 
Arrange Graphs feature distributes the available graphs on the x-axis.  

PrimaryHGraphY 950 Low-level system parameter that controls how the Horizontal Auto 
Arrange Graphs feature distributes the available graphs on the y-axis. 

Primary VGraphX 1000 Low-level system parameter that controls how the Vertical Auto Arrange 
Graphs feature distributes the available graphs on the x-axis. 

Primary VGraphY 600 Low-level system parameter that controls how the Vertical Auto Arrange 
Graphs feature distributes the available graphs on the y-axis.  

Default Section Graph System Sections Specifies the target graph used for the display of system generated 
section data.  

Default Spectra Graph System Spectra Specifies the target graph used for the display of system-generated 
spectral data. 

ReplicateRetreatStep 6000 Low-level system parameter that specifies how far the SoloVPE stage 
retreats during replicate measurements to allow for the switching of 
samples and Fibrette Optical Components. Avoids the need to return all 
the way to Home position. 

Inactivity Threshold 10000 Specifies the latency time in seconds that the Inactivity monitor feature 
will allow before disabling software features and requiring re-
authentication of the current user. 

RepLimit 6 Specifies the maximum number of replicates allowed to be made in the 
Quick Slope module. 

MaxRepDelay 300 Specifies the maximum amount of time between replicate 
measurements in Quick Slope when the Rep Delay features is enabled in 
the software. 

QSlopeReportTitle <Null> A string value that overrides the default Quick Slope report title. This 
global parameter can be changed for the system as the Quick Slope 
report title. 

IncrementalAutosave-
Folder 

True Toggles whether the Incremental Autosave feature creates a subfolder 
for each data acquisition event or if it places all incremental autosave 
files in a single folder. 

IncrementalAutosavePath C:\Users\Public\Documents
\cTechnologies\SoloVPE\ 

A string value that specifies the path to where incremental autosave 
files are saved. 

AutosaveDefaultState False Toggles the default state of the Autosave feature to either enabled by 
default or disabled by default. 
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DefaultMethodPath C:\Users\Public\Documents
\cTechnologies\SoloVPE\ 

The default path that will be used when saving Method Files from within 
the SoloVPE and QuickVCA software. 

MethodDigitalDigitsEna-
bled 

False Enables or disables a feature that allows users to specify the 
concentration display digits as an independent parameter within a Quick 
Slope Method, independent of the other concentration display digit 
parameter. 

InitialRepDelay 0 Low-level system feature that makes it possible to introduce a pre-
acquisition delay before the first or only data acquisition. Allows for 
sample settling to occur after Fibrette Optical Component zeroing.  

DoubleZeroStep 6 A low-level system parameter that makes it possible to control exactly 
how the Fibrette Optical Component zeroing action occurs. 

PlotThresholdSection True Enables or disables the plotting of the Quick Slope search results used in 
the Quick Slope data acquisition routine. 

AutosaveRTF False Enables or disables the output of an .RTF file in addition to the Autosave 
Batch File. The .RTF file that is saved is the formatted content of the 
Cary WinUV report pane content. 

SafetyPath C:\Users\Public\Documents
\cTechnologies\SoloVPE\ 

An Admin configurable path that the software uses for Safety Save 
events (in case of loss of network access). 

Default Low Abs Limit 0.1 Override parameter that allows administrators to change the default 
threshold value, which controls the display of the low absorbance alert 
in Quick Slope. 

Default High Abs Limit 1.25 Override parameter that allows administrators to change the default 
threshold value, which controls the display of the high absorbance alert 
in Quick Slope. 

Default Min Slope R2 0.999 Override parameter that allows administrators to change the default 
threshold value, which controls the display of the low R2 Alert in Quick 
Slope. 

Default QSlope AvgTime 0.25 Override parameter that allows administrators to change the default 
photometric averaging time value in Quick Slope. 

Default QSlope Target Abs 1 Override parameter that allows administrators to change the default 
threshold absorbance target value in Quick Slope. 

Default QSlope Datapoints 10 Override parameter that allows administrators to change the default 
number of data points to be collected in Quick Slope.  

Default QSlope 
Wavelength 

280 Override parameter that allows administrators to change the default 
wavelength value in Quick Slope. 

Default FSlope PL Start 1 Override parameter that allows administrators to change the default 
starting pathlength value in Fixed Slope mode in Quick Slope. 

Default FSlope PL Step 0.05 Override parameter that allows administrators to change the default 
Pathlength step size value in Fixed Slope mode in Quick Slope. 

Default FSlope WL List 280 Override parameter that allows administrators to change the default 
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wavelength in Fixed Slope mode in Quick Slope. 

Default MQSlope WL List 280, 350 Override parameter that allows administrators to change the default 
wavelength value. 

Default Slope Mode 0 Override parameter that allows administrators to change the default 
Slope Acquisition mode in Quick Slope (0 = Quick, 1 = Fixed, 2 = Multi-
Quick) 

 
5.8.3 SoloVPE Administration: Data Stores 

The SoloVPE software relies on a system-level data object called a Datastore. It exists as a database in the system. All users must 
have Read, Write, List, Read, and Execute rights to this object. It contains vital system parameters, audit trails, and other important 
system information. Network administrators should take necessary steps to enact appropriate security settings and backup 
protections on this important database as well as on the rest of the system. 
 

 
Figure 66. Data Stores within the SoloVPE Administration window. 

5.8.4 SoloVPE Administration: VPE System Service 

The VPE System Service provides another set of security-related features. The VPE System Service is an optional feature that is 
managed from within the UAC-secured SoloVPE Administration application.  
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Figure 67. VPE System Service within the SoloVPE Administration window. 

Administrators can install or remove the feature from within the application and toggle its state between started and stopped. 
These features are enabled or disabled by checking or unchecking the checkboxes provided. As a system-level service, it runs in the 
background and contains no user interface. It looks for events that require it to act. The three features that the VPE System Service 
provides are as follows: 
 

1. VPE Local File Locking: This feature was integrated to overcome the Microsoft file ownership permission vulnerability. As 
noted, file ownerships in Windows have permissions that cannot be overridden by NTFS settings on the local machine. Since 
file ownership is determined by the logged-in Windows user when a file is created, the VPE Local File Locking option looks 
for a WinUV file creation event and, when it detects one, will change the Ownership of the newly created file from the 
logged-in user to the administrator.  

• This change gives administrators the ability to set NTFS file permissions on local folders and protect files that could 
otherwise be subject to modification and deletion by the default owner. It is the recommended by Repligen that all 
method and data files be stored to a secured network location. 

2. Disable SoloVPE (WinUV) Menus: This feature was created to give administrators the option of hiding the standard Agilent 
WinUV menu bar. This eliminates the SoloVPE users’ ability to interact with unsecured WinUV features such as the standard 
File, Save Dialogs, and other menu bar options. 

3. Force Close ADL on Lock/Switch User: This feature will close the SoloVPE software if another user logs into the PC/Software 
or if the work station is locked. 

 
Note: Before implementing these features in the environment, it is important to fully understand their behavior. Hiding the Cary 

WinUV menu bar limits user ability to use unconstrained file pathing; however, it also eliminates access to standard Cary 
WinUV features that allow control of the Cary or quick access to the WinUV audit logs. This knowledge should be accounted 
for during implementation.  

 
Use of these features is completely optional, but their necessity should be evaluated by the implementation team. As noted, these 
features are accessible to all SoloVPE owners, even those that have not purchased SecureVPE. Repligen does not recommend 
exclusive reliance on these measures to achieve compliance.  
 
5.8.5 SoloVPE Administration: Manual Audit Log Entry 



  

 

 
 79 
DOC0126 eRev. 11/17/2023 11/17/2023   

User Guide CTech™ SoloVPE® System (V3 Software) 

The SoloVPE Administration application provides administrators with a way to make Manual Audit Log Entries. The Add Log Entry 
button appears on the main window of the SoloVPE Administration program and can be used as a form of diary for the connected 
SoloVPE System. 
 

 
 
Clicking the Add Log Entry button opens the Create Manual Audit Log Entry window that allows Administrators to type a detailed log 
entry for that system. This  feature gives personnel the option of creating notes or log entries for any information that is deemed 
pertinent to the system. A log entry could include details of unique maintenance or software updates that have been performed. 
 

 
Figure 68. Create Manual Audit Log Entry window. 

5.8.6 Support File Generation 

The inclusion of new support file features in the SoloVPE Administration application is a step forward for determining any database- 
and registry-related issue with the system. Using the support file feature in the application, the Administrator can generate a 
support file, which can be sent back to Repligen for further analysis. The support file also includes the database file directory for 
backups.  
 
5.8.7 SoloVPE Toolbar: Volume Pathlength Estimator 

The SoloVPE requires that enough sample solution is dispensed into the sample vessel to cover the range of pathlengths to be 
measured. The SoloVPE software includes a Volume Pathlength Estimator to assist users in determining the sample volume required 
to cover specific pathlengths.  
 

 
Figure 69. SoloVPE Volume Pathlength Estimator window. 
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The Volume Estimator allows users to select the sample vessel to be used and then will calculate either the volume requirement or 
the maximum possible pathlength for a given volume based upon user entry in the fields provided. There are a few sample vessel 
configurations available.  
 
Clicking the Chart button will print out a Volume: Pathlength Cross Reference for the currently installed vessels. Switching the 
selected vessels also allows the user to compare the volume required for a given pathlength for the different vessels.  
 
The Volume Estimator provides best estimates only and the maximum available volume should be used with each sample vessel to 
ensure accurate results. Factors such as the geometry of the vessel and the properties of the sample (such as density and viscosity) 
can affect the pathlength-filling efficiency. 
 
Volume Pathlength Estimator Provides Estimates Only: It is important to note that the volumes and pathlengths calculated are 
estimates only. Be sure to maximize volume when measuring unknowns using Quick Survey and Quick Slope. 
 
5.8.8 SoloVPE Toolbar: Extinction Coefficient Library 

The SoloVPE software includes a database entry where users can store the frequently used extinction coefficients called the EC 
Library. Once the extinction coefficient values are added to the library, the values will be available to other modules of the software 
such as Quick Slope and Analyze.  
 
Users can later update the values, and if the security package is implemented, the EC library is secured to prevent unauthorized 
edits.  
 
Listed below are the steps on how to add extinction coefficient values to the library. This also includes the abilities Import and 
Export Extinction Coefficient Library data to make manual synchronization between systems possible. 
 

 
Figure 70. Extinction Coefficient Library Utility window. 

5.8.9 How to Add Extinction Coefficient Values to Library 

1. Open the SoloVPE software. 
2. Click the EC Library either from the sidebar or from Start > Programs. 
3. Select Add EC to input new extinction coefficient values. 

• Name: This is a short name for the extinction coefficient. This name will be available when accessing the library for 
the input in all other software modules. 
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• Description: This is a more detailed description of the extinction coefficient, which provides more information 
about the item. 

• Owner: Individual responsible for the EC value, usually the person that created the entry. 
• Wavelength: The wavelength of interest, usually at a wavelength associated with the EC value.  

Note: Five wavelengths are allowed using the multiwavelength Slope method. 
• EC: The actual numerical value of the extinction coefficient. 

 

 
Figure 71. Extinction Coefficient Library Details window. 

 
6. General Troubleshooting 

The SoloVPE System is a robust and powerful system. Understanding its behavior is critical to getting the maximum results from it. 
This chapter describes possible unexpected performance of the system, what causes these conditions, and how to resolve the issue. 
 
Table 15. General troubleshooting issues and suggested actions 

Issue Cause Action 

Cary 60 Indicator Lamp 
Not Lit 

• The Cary 60 instrument is powered 
off. 

• Power is not reaching the Cary 60. 

• The Cary 60 is not plugged into a 
power outlet. 

• Confirm if instrument power is turned on. If not, press the 
power button located in the front of the unit to turn it on. 

• Check to make sure the power cable is securely 
connected to the Cary 60 and power outlet. 

Low Transmission 
(Failing Quick Check Test) 

• Possible contamination in the 
optical path reduces the amount 
of light available to make 
measurements. 

• Check transmission using the Quick Check Test to verify the 
functionality of the system. 

• Systematically cleaning the Delivery Fiber and SoloVPE 
Detector Window surfaces will help clear the optical 
path. 
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SoloVPE Not Moving • The SoloVPE has no onboard power 
supply. It draws power through the 
Accessory Cable that is connected to 
the Cary 60. 

• Improper connection to the Cary 60 
Accessory Port in the Cary 60 sample 
compartment.  

• The Cary 60 is not powered on. 

• Two-or-more SoloVPE software 
windows may be open. Only one 
can be connected to the 
instrument at one time. 

• Check transmission using the Quick Check Test to 
verify the functionality of the system. 

• Systematically cleaning the Delivery Fiber and SoloVPE 
Detector Window surfaces will help clear the optical 
path. 

Cary Displaying Red LED 
Upon Start-Up 

• Cary 60 is not properly calibrated. 

• Light is not being read by the 
sample and/or reference detector. 

• Power down the Cary 60 and restart the instrument. 

• Make sure Cary 60 is not plugged into an intermittent 
power supply. 

Hockey Stick Shape in 
Data Plot 

• The Fibrette Optical Component is 
bending in the sample. 

• Zero position has been changed or 
modified. 

• Broken pieces of Fibrette Optical 
Component are trapped in the 
Quick Set Coupler. 

• Check Zero Position with a large, empty vessel. Check 
Fibrette Optical Component for tightness by rotating the 
vessel in the holder. 

• Inspect Fibrette Coupler for broken pieces of Fibrette 
Optical Component, and clean or replace Fibrette 
Coupler if needed. Retest with a new aliquot to see if 
the hockey stick is present. 

Inconsistent 
Measurement Reading 

• Cary 60 is not properly calibrated.  

• Dirty vessel and/or Fibrette Optical 
Component. 

• The optical pathway is obstructed. 

• Restart the Cary 60 for self-calibration by turning the 
instrument off and then on. 

• Clean the Delivery Fiber. 

• Clean Fibrette Optical Component and sample vessel, or use 
a new Fibrette Optical Component and vessel. 

• Make sure the optical path is clean and that dust 
particles or debris are not present in sample 
compartment. 

Plateau in Section Curve 
Upper End (Similar Abs 
Values at Long 
Pathlengths) 

• Insufficient sample volume to cover 
pathlength range specified. 

• Fibrette Optical Component came 
out of the sample and resulted in 
a plateau in the pathlength cross-
sectional curve. 

• Add more sample volume to the sample vessel and 
repeat the test. Refer to Appendix 1: Sample Volume 
Help Sheet for additional guidance. 

Plateau in Section Curve 
Lower End (Similar Abs 
Values at Small 
Pathlengths) 

• Sample vessel or Sample Vessel 
Holder not properly installed/seated 
in the sample platform. 

• Incorrect sample vessel selected 
in the software. 

• Reseat the sample vessel and Sample Vessel Holder. 

• Confirm the correct sample vessel was selected in the 
software. 
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No Transmission • SoloVPE Detector Cable unplugged. 

• Possible broken Delivery Fiber. 

• Obstruction in the optical path. 

• Check to make sure the SoloVPE Detector Cable is properly 
connected between the Detector Port on the SoloVPE and 
the Detector Port inside the Cary 60 sample compartment. 

• Disconnect both ends of the Delivery Fiber and hold it up to 
the light to make sure there is not a break. If broken, contact 
Repligen’s Analytics Support. The light should be visible 
through the fiber.  

• Ensure that the Fiber Optic Coupler is set in the proper 
position. 

Noisy Spectra • Poor optical alignment. 

• Obstructed optical path. 

• Cover not lowered into data 
collection position. 

• FC connector of the Delivery Fiber 
not fully secured. 

• Confirm that the cover is slid into the down position prior to 
measurement. 

• Clean the optical path. 

• Restart Cary 60. 

• Check and secure the FC connector of the Delivery 
Fiber on the SoloVPE Translation Stage. 

Unable to Access 
SoloVPE Software (Error 
Alerts) 

• Permissions may not be set 
properly after a computer was 
connected to a network. 

• SoloVPE software uses Windows active directory for 
permission—confirm that the user has proper 
permission to access software according to VPE 
Software: SoloVPE Software V3 Security Configuration 
KB16008. 

No Light Coming from 
Cary 60 

• Cary 60 or Fiber Optic Coupler could 
be misaligned. 

• Xenon flash lamp could need 
replacing. 

• Perform a Coupler Check (see Section 5.3.14). Follow 
the No Transmission Actions. Then, if results are still 
Zero, please contact Repligen. 

Random Spikes in 
Spectra 

• Cary 60 is not calibrated properly. 

• SoloVPE detector is malfunctioning 
and could need replacing.  

• Xenon flash lamp could need 
replacing. 

• Restart Cary 60. 

• Run CHEM013 standard to verify the accuracy of the SoloVPE 
Detector.  

• If you suspect the Xenon flash lamp needs replacing, 
contact Repligen. 

 
For additional assistance, please call VPT Support at (908) 707-1201 or email analytics-support@repligen.com 
  
  

mailto:analytics-support@repligen.com
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Appendix 1 | Sample Volume Help Sheet 

When using the variable pathlength technology  of the SoloVPE System, it is always important to make sure that enough sample 
volume has been dispensed to cover the range of pathlengths to be measured. Use the following suggestions and the volume matrix 
provided in Table 16 to help guarantee adequate sample volume is available for the desired measurement pathlengths. 
 
For estimated volumes for use in concentration determination, please reference Section 4.7 or view CTech SoloVPE Best Practices 
DOC0153. 
 
Tip: When using the Quick Tools such as Quick Slope and Quick Survey, it is always preferable to use the maximum volume allowed by 

the sample vessel being used.  
 
Table 16. Sample volume matrix. 

Vessel Vessel Name Pathlength (mm) Minimum Volume (ml) 

 

Micro Vessel 

0.1 0.010 

0.2 0.010 

0.5 0.010 

1.0 0.013 

2.0 0.025 

5.0 0.062* 

 

Small Vessel 

0.1 0.010 

0.2 0.010 

0.5 0.012 

1.0 0.025 

2.0 0.050 

5.0 0.125* 

 

Large Vessel 

0.1 0.016 

0.5 0.080 

1.0 0.160 

2.0 0.320 

5.0 0.800 

10.0 1.600 

12.5 2.100 

15.0 2.400* 

 

Plastic Vessel 

0.1 0.010 

0.2 0.010 

0.5 0.012 

1.0 0.024 

2.0 0.048 

5.0 0.063* 
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Appendix 2 | The Derivation of the Slope Spectroscopy Equation 

The SoloVPE System is the enabling technology for Slope Spectroscopy methods. The Slope Spectroscopy equation is derived from 
the Beer-Lambert law. The standard equation of a line is as follows: 
 

Equation Definitions 

  
Beer-Lambert Law 

Where: 

 A  is the absorbance of the sample. 
 Ꜫ  is the absorption coefficient or the molar absorptivity of the absorber. 
l  is the distance that the light travels through the material (the pathlength). 
c  is the concentration of absorbing species in the material. 

 
Linear Equation 

Where: 
y  is the predicted value of the dependent variable/axis. 
m  is the slope of the line. 
x  is the given variable. 
b  is the y-intercept of the line. 

 
Derivation and Version of the Slope Spectroscopy Equation: 

 

 
  

We know therefore, 

and 



  

 

 
 86 
DOC0126 eRev. 11/17/2023 11/17/2023   

User Guide CTech™ SoloVPE® System (V3 Software) 

Appendix 3 | SoloVPE Pathlength Defined 

To clearly show how the pathlength is defined, Figure 72 shows a SoloVPE sample vessel and Fibrette Optical Component as they are 
used in the SoloVPE System. The pathlength is defined by the tip of the Fibrette Optical Component and the bottom of the sample 
vessel.  
 
By dynamically changing this gap, the SoloVPE System can produce thousands of different pathlengths for measurement.  
 

 
 

Figure 72. SoloVPE pathlength geometry. 
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Glossary 

There are many terms, definitions, and naming conventions associated with your SoloVPE System that are helpful to know and 
understand. This section of the manual provides an overview of these concepts and serves as a quick reference. 
 
This glossary contains content developed by Repligen subject-matter experts or retrieved (whole or in part) from the American 
Society for Quality glossary, the International Accreditation Forum website, and Spectroscopy magazine’s “The Molecular 
Spectroscopy Terminology Guide” online.  
 
Absorbance Plateau: Generally obtained by taking a slice from a variable pathlength surface, this is a 2-dimensional data set created 
from pathlength versus wavelength data at a specific (constant) absorbance level. 
 
ADL Shell: The Application Development Language (ADL) Shell is a program template provided with the Cary WinUV software suite. 
It provides the basic environment and common functionality associated with all the Cary WinUV applications. It is the platform on 
which customer applications can be developed for use with Agilent’s line of spectrophotometers and is the foundation of the 
SoloVPE Control software. 
 
Application Development Language (ADL): A powerful programming language provided with the Cary WinUV software suite. It can 
be used to customize existing programs that work with Agilent spectrophotometers and the SoloVPE, as well as to develop custom 
applications.  
 
Averaging Time: The Cary Spectrophotometer setting that configures how long the system will collect data at each wavelength. Able 
to be configured in seconds, this number corresponds to many pulses of the Xenon flash lamp. One pulse corresponds to 1/80th of a 
second or 0.0125 seconds; therefore, each second is 80 pulses of the lamp. 
 
Baseline Measurement: The beginning point, based on an evaluation of output over a period of time, used to determine the process 
parameters prior to any improvement effort; the basis against which change is measured. 
 
Beer-Lambert Law: The law of physics that describes the proportional relationship between absorbance, pathlength, and 
concentration.  
 
Continuum: The name used to describe a collection of XY data points stored in the software or computer memory. An example of a 
continuum is a spectral curve or spectrum, which is a series of points defined by a wavelength value and an absorbance value. 
 
Delivery Fiber: The fiber-optic cable that carries light from the Cary spectrophotometer to the variable pathlength device. 
 
Detector: A device used to detect light being transmitted through the sample. 
 
Detector Cable: This component sends absorbance information from the VPT instrument to the Cary 60 to be analyzed and 
displayed for the user.  
 
Detector Window: The transparent, protective cover of the VPT instrument’s Detector.  
 
Extinction Coefficient (EC): An intrinsic property of a substance, described by a numerical value that quantifies the propensity of a 
substance to absorb electromagnetic radiation at a specific wavelength. It is one of the terms used in Beer-Lambert law (ԑ). 
 
Fibrette Optical Component: The component of the SoloVPE system that delivers the light from the Delivery Fiber to the sample. It 
allows the measurement pathlength to be changed based upon its vertical motion within the sample. 
 
Fixed Slope Mode: A Quick Slope feature in which the user will need to provide the defined starting pathlength, step size, and the 
number of data points used.   
 
Fixed Zero: The position the system drives down to prepare the SoloVPE and Fibrette Optical Component for data acquisition. When 
in this position, the Fibrette tip is in contact with the bottom of the sample vessel. All pathlength parameters and motion are 
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referenced from this position, which corresponds to a pathlength of zero millimeters. Also referred to as Zero Position and Zero 
Pathlength. 
 
Home Position: This is the fully raised position of the SoloVPE System. This allows maximum access to the sample vessel, sample 
vessel holder, and the Fibrette Coupler. It is the position the SoloVPE needs to be in for loading and unloading of Fibrette Optical 
Component and Fibrette Couplers for the SoloVPE System. 
 
Insert Holder: The component of the SoloVPE that holds the Quick Set Fibrette Coupler Insert, connecting it to the Translation Stage. 
 
Multi-Quick Slope: This is like Quick Slope Mode but with the added benefit of using one to five wavelengths and their 
corresponding extinction coefficients, if applicable.  
 
Pathlength: The distance the measured light travels through the sample when making absorbance spectroscopy measurements 
based upon the Beer-Lambert law. In the variable pathlength system, this distance, generally expressed in millimeters, is defined by 
the physical gap between the bottom of the sample vessel containing the solution and the tip of the Fibrette Optical Component 
that is submerged in the sample. 
 
Quick Check: A variable pathlength software utility that allows users to rapidly assess the health and cleanliness of their variable 
pathlength system by making a series of transmission measurements.   
 
Quick Method: A predetermined Quick Slope Method. There is a Standard Quick Slope that uses a typical 280 WL to determine 
concentration. Another method included is High Concentration Fixed Slope starting at 40 microns with a five-micron step size using 
seven data points.  
 
Quick Section: An absorbance versus pathlength plot generated in real time as data acquisition occurs. As data is collected, the 
curve(s) are created by extracting the absorbance vs. pathlength data at the desired wavelength. 
 
Quick Set Fibrette Coupler: The current Fibrette Coupler design. Comprising the stainless-steel Insert and the black-plastic Insert 
Holder, it allows consistent positioning of the Fibrette Optical Component.  
 
Quick Set Fibrette Coupler Insert: The stainless steel Fibrette holder. A replaceable, disposable part to be used with the Quick Set 
Fibrette Coupler.  
 
Quick Slope: A variable pathlength software utility that rapidly creates section data using the SoloVPE system. By making 
measurements at various pathlengths, the utility searches for the linear range of the sample, in compliance with Beer-Lambert law. 
Once found, section data (absorbance vs. pathlength) is collected. A linear regression is performed on the data set to determine the 
optimized slope value, which can then be used for quantitation. By default, ten data points are collected. 
 
Quick Survey: A scanning utility to rapidly collect multiple spectra at a wide range of pathlengths to quickly determine the 
wavelengths (absorbance peaks) of interest and required pathlength ranges.  
 
R2 Value: Coefficient of determination. A statistical value between 0.0 and 1.0 that indicates the quality of the linear relationship 
between two variables in a data set. An R2 value near 1.0 indicates a near-perfect linear relationship between the data. In Slope 
Spectroscopy, section data is regressed, and this value is used to identify the level of compliance with the Beer-Lambert law within 
pathlength regions. 
 
Recollect: A feature in the Quick Slope module that allows users to make multiple slope measurements of a sample using the same 
Fibrette Optical Component, sample vessel, and sample aliquot by keeping the Fibrette Optical Component submerged in the sample 
solution between individual measurements. Recollect will use the same initial search for subsequent data collections.  
 
Repeat: A feature in the Quick Slope module that allows users to make multiple slope measurements of a sample in which the 
SoloVPE repeats the search algorithm and collects the data based on the new search results without changing the Fibrette Optical 
Component or aliquot. 
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Replicate: A feature in the Quick Slope module that allows users to make multiple slope measurements of a sample in which the 
SoloVPE returns to the home position between reps to allow the user to change the Fibrette Optical Component and aliquot before 
the next rep is completed. Each rep will include both the search and collect action. 
 
Rep Delay: This feature allows the users to set a delay between either the Recollect, Repeat, or Replicate mode from 0 to 300 
seconds or up to five minutes. 
 
Rep Mode: Style of repetition chosen in Quick Slope for continuous sample measurements. Each rep mode take place with either 
the Fibrette Optical Component staying in the sample vessel and/or if a new search algorithm will take place before a run or not. 
 
Sample Vessel: The component of the SoloVPE system that holds the sample to be measured. There are different sizes (volumes) of 
sample vessels and materials (fused silica and UV plastic). 
 
Sample Vessel Holder: The component of the SoloVPE system that properly secures the sample vessel in the instrument in 
preparation for measurement. Sample vessel holders come in different configurations to match the style of sample vessel being 
used (micro/small and large).  
 
Scanning Mode: A configuration mode that can be applied to either the Cary spectrophotometer or the SoloVPE unit. For the Cary 
spectrophotometer, Scanning Mode allows the collection of spectral data across a range of wavelengths based upon a user-specified 
starting wavelength, stopping wavelength, and wavelength step size or data interval. For the SoloVPE, Scanning Mode allows the 
collection of absorbance information across a range of pathlengths based upon a user-specified starting pathlength, stopping 
pathlength, and pathlength step size. 
 
Scatter Correction: The absorbance value correction that subtracts out absorbance contributions associated with the molecular 
interaction with the incident light or particle dispersion. 
 
Section: In Slope Spectroscopy, an XY data set made up of absorbance data as a function of pathlength at a fixed wavelength.  
 
Slope Spectroscopy®: An analytical technique based upon the Beer-Lambert law, which utilizes the slope term of a statistically 
analyzed absorbance vs. pathlength plot to make calculations and predictions of sample properties.  
 
Solo Validation Cuvette Adapter: The SVCA is an optional accessory that provides an additional technique for validating the SoloVPE 
device and specifically allows the use of filters and standards based on a cuvette form factor. 
 
SoloVPE (Variable Pathlength Extension): The variable pathlength instrument that enables Slope Spectroscopy measurement 
methods. 
 
SoloVPE Software: The computer applications that provide primary control of and access to the features and functions of the 
SoloVPE variable pathlength system. 
 
Special Characters: There are many special characters that the SoloVPE software uses and these should be avoided in sample 
names. The special characters are explained as follows: 

{ Open Bracket designates the beginning of the sample name. 
}   Closed Bracket designates the end of the sample name. 
@   The “at” symbol indicates the specific pathlength or wavelength at which the continuum was acquired or constructed. 
, The comma is used to separate fields in a comma delimited file. 

 
Spectrum/Spectra: In absorbance spectroscopy, XY data set(s) made up of absorbance data as a function of wavelength at a fixed 
pathlength. 
 
TBA Fibrette Coupler: The older version of the Fibrette Coupler, which requires a manual pulldown to create the offset for the Zero 
Position.  
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Threshold: A user-specified limit specified in absorbance units (Au) that the SoloVPE system will scan the pathlength range to find, if 
possible. 
 
Trace: A continuum that is currently displayed or plotted on a graph as a curve. 
 
User Result:  Allows users to create an equation for their reports using algebraic expressions that incorporate the slopes generated. 
 
Zero Pathlength: The position the system drives down to to prepare the SoloVPE and Fibrette Optical Component for data 
acquisition. When in this position, the Fibrette tip is in contact with the bottom of the sample vessel. All pathlength parameters and 
motions are referenced from this position, which corresponds to a pathlength of zero millimeters. Also referred to as Zero Position 
and Fixed Zero. 
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